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Standard Operating Procedures for the Alternative Format Services
Alternative Format Services (AFS) is a component of Technology Access Program (TAP) of Oregon State University. We work in conjunction with the Office of Services for Students with Disabilities (SSD) to provide equal access through technology to students with disabilities.

The materials that we receive are textbooks, articles, syllabi, handouts, class notes, quizzes, tests, and any other material needed by the student for a particular course. Upon receipt of the material, we convert it into electronic formats such as RTF, PDF, DOC, CDs, DVDs or other alternative formats, including Braille, as requested. 
Startup

Follow these procedures at the beginning of the workday:

1. Check your email before coming to work, if possible, and respond to messages as necessary. If you are not able to access email prior to your arrival to work, make sure you check it prior to beginning your assigned tasks. Emails are an official form of communication and you must reply promptly to them when a reply is indicated. 

2. We use an OSU email list to communicate with the AFS group internally. The email address is Alt_Format@lists.oregonstate.edu.  

3. Please enter the office through the staff entrance doors, room 114. If these doors are locked, you may enter through the front entrance of the Media Services, Kidder 109.

4. You may work a maximum of eight hours a day for up to 20 hours a week during the term and up to 40 hours a week during the break. You cannot work more than eight hours a day at any time.

5. You may take a 10-minute break for every two hours of continuous work. Please inform a team leader when you take a break. If you need to leave the office for more than 10 minutes, you will need to clock out. 

6. If you are not able to attend your assigned slot, please make sure to inform us as far in advance as possible. When notice is short, call the office, 541.737.9272, and speak with a team leader to let them know you will miss your slot. As soon as possible, send a follow up email to ........@Oregonstate.edu and copy ........@Oregonstate.edu, indicating the reason for your absence. Make up of missed time will only be allowed when these procedures have been followed.
7. Store your belongings under the bookbinding cutter and hang all coats on the coat tree. Our space is limited and it is very important that we keep all walkways clear.

Clocking in

1. You may clock in and out at any of the computers in the office.

2. The time clock address is:

https://scf.oregonstate.edu/stu_mgmt/student/clockit.php .

3. Click “Time Clock” and enter your Student Identification Number,
4. Click the Alternative Format Services radio button and press enter. A page will be displayed with the time that you have clocked in (or out) and the total number of hours that you have worked during that day/week.

5. If you forgot to clock in/out you can have corrections made by sending a request, from the time clock program, to the supervisor. Follow these steps to send in a request:
a. Click on “Student Home”

b. Click on “View or change your time clock records”

c. Enter your Student ID number and Click “View Records”

d. Select appropriate date and click “Change or Delete”

e. Enter the corrections; and the reason for the request. 

f. Click “Make request” and you are done.

6. The supervisor will contact you if they have any questions.

Timesheets

Timesheets are due at the end of your shift on the 15th of every month. The following steps are to be used to create a timesheet from the time clock program:

1. Click on “Create Timesheet”

2. Enter your Student ID number 
3. Select the time period 
4. Click “Create Report”

5. Print out a copy in landscape mode, 
6. Sign it
7. Turn it in to your supervisor. 
Courier Runs

· The courier run is twice a day. 
· We, AFS, will deliver and pick up materials for Alternative Format Services (AFS) and Caption from SSD, Sea Grant and other offices on campus as needed.
· Be sure and verbally check with the Caption section prior to departing on the courier run.
· The courier runs are at 11 am and 2 pm. 
· AFS is responsible for the 11 am courier run
· The 2 pm courier run is handled by Caption
· The drop off and pick up box is located behind the front desk at the SSD office.
· Please make sure you take the Courier ID badge when you do the run. It is located on the wall by the clock.
About Hardcopies:

Hardcopies are the actual pages of the material being converted as opposed to the softcopies, which are the electronic versions of the material.

· It is important that each person take only the section on which they are working and not the entire chapter. For example, if you are assigned section 2.3 from Math 341, do not take all of chapter 2. 

· Handouts and class notes are never to be kept in your personal folder.

· When you are finished editing for the day, be sure to place the hardcopy back into the appropriate folder and in the correct order.

Finishing up for the day

 When you are finished working for the day, you must: 

1. Log out of the database 

2. Clock out.

3. Log off the computer 
4. Wipe down the keyboard, mouse, and work area with a disinfectant wipe.
Preparations for the Term

Version 1.0
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Preparations for the term

Folders on Alternative Format Services server:
· Create the folder for the term on Alternative Format Services server

· Create subfolders for each student

· Create excel tracking sheets: 

· One for each student’s handouts, homework, etc.

· One for files sent and when

· One for textbook log

· One for teacher/student contact list

· In the subfolders for the students, create folders for the courses the student is taking for that term.

Emails:
· Make a copy of all the emails received from the Student/SSD/AFS Supervisor and place them in a folder (for that student) in the top drawer of the brown file cabinet.

After receiving the books/material from SSD:

· Log it into the textbook log excel sheet

· Textbook log: tells us the date we received the book, from where, author, ISBN, requested format, and any comments

· Create the folders in Alternative Format Services (>Student #>Course) for the book (Corrected, completed, rtf, etc.).


Book cutting

Once the authorization to cut the books is obtained, cut them following the guidelines and common safety precautions.
· Pay attention throughout the entire process.

· Place the material behind the cutting blade with the spine of the book facing you and the edge of the book resting against the grate.

· Lift the cutter arm up and out of the way.

· Using the wheel on top of the book cutter, lift the pressbar by turning the wheel counterclockwise until there is enough clearance for the book.

· Move the book into place using the handle on the front of the book cutter.

· Do not place fingers under the shield or near the blade of the book cutter.

· Crank the handle clockwise to move the book forward into position.

· Once the spine of the book is in the middle of the red tape (the dip in the cover where the spine meets the rest of the book is the perfect place to position for the cut.) stop cranking the handle.

· Next you will grasp the wheel on top of the cutter and turn it clockwise until the book is secured. (Turn the wheel until it cannot be turned any further.)

· After securing the book, grasp the cutter handle and bring it down completely. 

· Now the spine of the book will be lying in front of the cutting blade and the rest of the book will be behind it.

· Pick up the book from the rear of the cutter.

· Follow current guidelines for preparing the material for conversion.
· What to do with the hardcopy

· Make labels for the shelf and the folder. If possible, try to make sure that one student gets the same color folder for all of his/her classes for the term

· Enter the book into the database

· Make a copy of the table of contents to put in the table of contents binder

· Separate the book into sections

· Have one person scan the entire book

· The scanned files go into the respective RTF folders. 

· Start assigning the book

After Receiving the Student’s Schedule
· Clear the top row of the hardcopy shelf

· Make a teacher/student contact list (or copy/paste info from current term into next term excel sheets.) to determine who is teaching the course:

· Look for the course in the course catalog and look to see if a professor is listed

· Do a search for that course on the OSU website

· Search the specific department homepage; there is often information about what courses are offered the following term and who’s teaching it

· Get their information from the online directory

· Look for previous syllabi (or current syllabi if available) for those classes

· On the internet (OSU website)

· If the teachers are known, look for the teacher in the appropriate department(usually the website is listed when you click on the teachers name

· If the teacher is not known, then look for the course itself.  This can usually be found on the department homepage under “Courses”

· Enter dates the sections/chapters are due into the File Status/File Sent Excel sheet

· Determine what textbooks are needed for that course (some courses list multiple books on the syllabus but all of them are not required)

· Contact SSD to find out if the books are available. 

· Go to the bookstore website and enter in the courses to find out what books are needed

· Determine if there are handouts or class notes that will be needed for the course(s).  Enter these details in the File Status/File Sent Excel sheet

· Check the Course website regularly for any updates. (Usually the syllabus is updated at least once.)

Assigning work

· Once the tasks are created in the database and the files scanned, those tasks are ready to be assigned to the team members. This is done according to the syllabus.

· There is a high probability that the student will request some additional material to be posted (even if it is not mentioned in the syllabus for that week). These tasks become high priority and posted as quickly as possible. 

Correcting the edited files:
· The edited files are to be corrected by a Senior Editor/Team Leader.  Once the correction is done the files are moved to the correction folder.

Posting the Material:
· The corrected files are now ready to be posted.  All the material required should be posted at the very latest by the Friday of the prior week it is due to be used by the student.

· Open the Student online database folder from the desktop shortcut.

· Make the required folders in this directory according to the term and courses.

· Copy the files from the Alternative Format Services server and paste them into the appropriate folder on the Student server.

· Access the online student server from an internet browser to make sure that the posted files are accessible.

· Update the File Status/File Sent Excel sheet.
Alternative Format Services Database
Version 1.0
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I. 
Purpose

a. 
Provide general users with an interface to view current assigned 


tasks and to record time spent on each task.

b. 
Provide team leaders and administrative users with an interface to 


create, modify, and assign tasks to other users as well as to 



categorize tasks according to student and class.

c. 
Record user-inputted data for time spent on different tasks.  

Provide on-line accessible reports showing cost analyses of production 
hours and administrative overhead.

II. 
Interface
a. 
Navigation

b. 
User list and user management.

c. 
Student work management


1. Student, class, work and task structure


2. Task assignment and user data entry

III. 
Reports
a. 
Online production reports

b. 
Online administrative reports

I. 
Purpose

The AltFormat online database is designed to function within three essential areas of operation:

· To provide general users with an interface to view current assigned 
tasks and to record time spent on each task.

· To provide team leaders and administrative users with an interface to create, modify and assign tasks to other users as well as to categorize tasks according to student and class.

· To record user-inputted data for time spent on different tasks and to provide online accessible reports showing cost analyses of production hours and administrative overhead.

Converting classroom material into an electronically accessible format is one of the key duties of the Alternative Format Services.  Since the average Alternative Format Services editor may convert or edit a high volume of material per day, the database must therefore serve as a portal for users to track and manage the various amount of tasks associated with e-text conversion.
II. 
Interface

Navigation

Navigation throughout the database is facilitated by the sidebar located at the left of the page.

[image: image1.emf]The navigation sidebar allows users to access different functional areas of the database.  The sidebar will appear different; however, to users with different privileges.

A standard user will only be able to access those links, which are outlined here in green.  These links will allow the standard user to view and enter data for currently assigned tasks, as well as access the Daily Tasks/Admin Work form for recording time not directly related to production.

A team leader is able to view the links outlined in blue.  Aside from being able to view the online production reports, a team leader is also able to create and edit students, classes and work as well as creating and editing individual tasks for different work.

The admin user has access to the link outlined in red.  This is the Manage Users link.  The admin user has privilege to create new database users, as well as determining the privilege level for other users.

User List and User Management

A team leader or admin user, after logging in, will automatically be directed to the User List page, shown next.
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Media Access Group: User List page
From here, one is able to view the number of tasks or jobs currently assigned to each database user.  The Details link enables the user to view the specific details about the tasks that are assigned.

A user with admin privileges is able to create users and modify user information in the Manage Users screen.

[image: image6.png]List Users | Add Users
Media Access Group: Manage Users

Standard Users: Team Leaders Admin Users,

15 Standard User 1 Edit|| 10029 Tear Leadsr User 1 Edit| 160 Admin User 1 Edit
31 Standard User 2 Edit 1 Admin User2 Edit
56 Admin User 3 Edi

In-Active Users:

12 Inactive User 1 £dit
B

11 Insctve User 2
9 Inactive User 3 Edit
8 Inactive user 4 gdit





Manage Users Screen
The screen above shows the different privileges assigned to each database user.  An admin user can click the Edit link next to any user name to change their information and privileges.

Student Work Management

For each student the Alternative Format Services, a set of work is assigned.  The work for the student is any course material that needs to be converted: course books, class notes, handouts, articles, etc... 
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Team leaders and admin users have access to the Work link, which allows them to view a list of the work associated with each student and class.
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Active Work List
The active work list is a list of the work for all students and classes.  By clicking the Classes link under Work in the sidebar, it is possible to view the list sorted by class.
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Class List

By clicking on the link for the class, the user will arrive to the Active Work List screen for that particular class.

For any given work there exist a number of tasks, separated into chapters, sections or page ranges, to which a database user will be assigned.  For each of these tasks there are editing, correction, scanning and possibly tactile graphics tasks to be carried out by database users.

In the Active Work List page, clicking on the title of the work will bring up the Active Tasks page.  This page shows a list of the tasks that are associated with that given work.  Below is a sample of what the Active Tasks page might look like for a sample course book.
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Active Tasks Page

Clicking on the name of the task will show the user(s) to whom a certain task is assigned.  Normally one user is assigned to scan the book, so that it is done all at once and not section-by-section.
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Task Assignment Page

In this page, users are assigned to work on different parts of the task (also referred to as “tasks”).  For example, a user may be assigned to edit or convert the task into e-text.  Another user is then assigned to correct this task by proof-reading it.  Given the student’s preference for the representation of figures and diagrams, a tactile graphics or photocopy task may also be assigned.

Once a task has been assigned, the user can view his or tasks by clicking the User Tasks link on the sidebar.  The screen below shows the tasks assigned to the current user.  It is also the default screen when a standard user logs in.
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User Active Tasks Page
This screen also includes the form for entering the number of hours and pages worked on.  A comment field is also provided.  After the task has been completed, the user can click the close link, which marks the task as complete.

III. 
Reports

Team leaders and admin users have access to the online reports located under Reports in the navigation sidebar.  The database collects the user inputted data from the User Active Tasks page and displays it sorted either by Student/Book, Student, Book, or Class.  The report below is a sample report sorted by Student/Book.  Other reports contain the average pages per hour column.
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Sample report sorted by Student/Book
Just like the time spent on production tasks, the time spent working on administrative and daily tasks must also be accounted for.  Every user has access to the Daily Tasks/Admin Work link, which allows time to be entered for tasks not directly related to production.

These tasks are divided into the following categories: database work, meetings, interviews/hiring, schedule work, training, reports and other.

The report shown is a breakdown of production (editing, correction, scanning and graphics) versus administrative tasks.
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Production vs. Admin Tasks sample report
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Introduction
This document meant to train people in various procedures of the Alternative Format Services. It describes the procedures that are to be followed while editing any document. 

The documents to be edited generally fall into three categories based on the type of software used to read/print them. They are:

· Documents that are read using Triangle.

· Documents edited using MathType and printed on the Tiger Printer.

· Documents edited in Plain Text and read using various screen readers such as OpenBook

Scanning Directions
Scan the entire book. If the book is rich in pictures and colors, you may want to use the OmniPage Pro scanning program. Otherwise, use the Abbyy Fine Reader scanning program. Instructions for each program can be found on the Alternative Format Services server in the Scanning\Scanning Items directory. 
Capture Perfect 2.0

Quick Reference

Basics:

This software is used for scanning documents (papers) into images that are Optical Character Recognition (OCR) software compatible. The images that are scanned are saved in “.TIFF” format by default, which works perfectly fine with OCR software such as ABBYY Finereader 7.0. Capture Perfect 2.0 is also very compatible with the Canon Scanner DR9080 (Scanning tips for this device included later in document).

Procedure to Scan Using Capture Perfect 2.0 Software:
1. Open the “Capture Perfect 2.0” shortcut on the desktop. (If shortcut is not present, ask a Team leader to set it up).

2. Place the paper in the scanner (details explained in DR9080 tips).

3. On the Capture Perfect 2.0 menu bar, click “File” then “Scanner Setting… .” A window for scanner settings will appear (this window may read “Canon DR-9080C on STI - 0000”). In this window:

· According to the paper size you have (please measure using a scale), select “Page size (a)”. If it’s a common size that repeatedly occurs for several books, you can save it in the “User Preference” box. (Common size and settings for Class Notes is saved).

· Note: If Landscape orientation, it can be selected from the same setting by choosing the (Rotated) Option”.
· Note: As a reference, A4 (210 x 297 mm) is the size you would select to scan a normal sheet of paper.

· The “Dots per inch (b)” (dpi) option should be chosen from 600 (if font size in the document is really small) to 400 (normal-sized font in the document), rather than the default of 300 dpi. This is for Compatibility with Finereader.

· “Mode (c)”, “Brightness (d)” and “Contrast (e)” settings are not to be changed.

· “Scanning Side (f)” is chosen according to whether the document is double sided (Duplex) or single sided (Simplex).

· “Feeding Option (g)” and “Scanning Option (h)” are not to be changed. Keep the standard settings (“Standard Feeding” and “Scan Ahead,” respectively).

· These options in the main settings window are followed by button options (For e.g.: “Area... ,” “More... ,” “About... ,” etc.). Click on “Area...” from these options. In the “Scan Area” window that pops up, you can change the distance from the left and top borders of the page by changing the “Start X: (i)” and “Start Y: (j)” options. The defaults for these options are 0” (inches). Click “OK” when you are done.

· Note: If you need to use the “Preview” for choosing the scanning area (currently unavailable in Capture Perfect 2.0), please make sure that you place the page that was scanned back on top of your paper stack before hitting the “Scan” button.

· Hit “OK” in the settings window to save your settings.

4. Now again from the “File” options choose the “Scan Batch to File” option. Choose the location and the format. (Keep this file on the Desktop and save as a TIFF file) On the “Start scanning” window that appears, click “Start Scanning.”

Note: If you use the word “temp” as the filename (not temp.tif!), the file that you create during scanning will replace “temp0001.tif” on the desktop. Doing this will create a lot less clutter on the desktop and is highly advised. If you choose to do this, click “Yes” when you are asked to over-write the existing file.

5. When you are asked to continue scanning, click the “Stop Scanning” button. The scanned “image” opens up once scanning is completed and you can choose to look at any page by choosing the “Page” option from the main menu bar. Another method for viewing pages is using the Split View. You can obtain Split View by clicking “View” on the main menu bar, then “Split View,” then a number based on how many pages you want to see on the screen at once. The options are 1, 2, 4, and User Setting.

Using Canon DR9080

1. Turn on the scanner by hitting the power button at the bottom left corner of the device (Device is usually powered on and usually no buttons on the scanner have to be used).

2. Place the paper in the bottom feeder tray and adjust the paper size levers so that paper is held between them. This allows the paper to go straight into the scanner. Paper should be placed in the tray with the top of your document pointing towards the scanner and face up.

3. You can pull out the extension tray at the feeder for larger documents.

4. Pull out the extension tray at the top for proper collection of documents after scanning.

5. For manual feed hit the “Bypass Mode” button on the panel and feed in paper manually.

6. The “Count Only” button does not scan but counts the pages of the document that is fed in.

7. Another feature is by setting a “Patch code” (example given in the manual) on pages that separate 2 documents. The entire set of documents could be scanned together, but saved in separate files.

8. Use the software as described above to start scanning.

Note: Always remove staples or any other binding devices from pages before scanning. If the corners are bent, flatten the creases and then put the paper back in the feeder tray. If the paper gets stuck, call a team leader or a tech. The manual for such troubleshooting is kept underneath the scanner.

9.  Save the scanned data in RTF (Rich Text Format).

10 The document should be saved in the corresponding folders  based on the current file naming convention.

Naming Conventions
This process is subject to change. Check with a Senior Editor for the current Naming Conventions.
Note: Some screen readers have problems recognizing periods (.) that are used in the file name, other than those indicating file type (i.e.: .doc, .rtf, .txt, etc. ...). Please use an underscore “_” instead of a dot in these circumstances.

Note: CN stands for class notes and HO stands for handout. Date of class is done in mm_dd_yy format.

The Course Equivalents to be used are...
Physics = PHY
Math = MTH



Education = ED
Biology = BIO



Psychology = PSY
History of Science = HSTS



French = FR
Business Administration = BA
 

Computer Science = CS   Communications = COMM 



Engineering = ENGR
English = ENG

Chemistry = CHE
History = HST

German = GER

Before Editing
This is where most tasks start. You will be given an assignment to edit a document that has been already scanned. This is the checklist of all that is to be done before you start editing.

1. Open the original RTF file of the task that you have been given (should be found in the RTF folder under the term, student, course, and then book of your assigned task).

2. Copy and paste the entire contents of the file into a new Notepad document (Start button > Programs > Accessories > Notepad). This will get rid of any figures, images, text boxes, and any other unwanted formatting. At this point, copy and paste the entire contents of the Notepad window into a NEW Word document.

3. Save the file according to the naming conventions listed in the section above. All files editing using TRIANGLE and PLAINTEXT have to be saved as .RTF files. All files edited using MATHTYPE have to be saved as .DOC files.

Editing Procedures
Page Setup: First, select all the text (CTRL + a) in this new document and change the following:

Font Dialogue Box
Open up the Font dialogue box. This can be done by selecting Format from the main menu bar then Font. 

Under the Font tab (default)...

Font: Arial

Size: 12pt

Under the Character Spacing tab…

Scale: 100%

Spacing: Normal

Position: Normal

Paragraph Dialogue Box
With the whole document still selected, select Format from the main menu bar then Paragraph. Under the Indents and Spacing (default) tab...

Alignment: justified

Indentation Left: 0”

Indentation Right: 0”

Indentation Special: None

Spacing Before: 0pt

Spacing After: 0pt

Line spacing: Single

1) Page Numbering: Page numbers must be inserted on every page. A page number should be inserted before the first paragraph of a page. However, if the first paragraph of a page doesn’t start until halfway down, and that paragraph only has a few lines on the previous page, you can put the page number in front of that paragraph. DO NOT BREAK PAGES unless it is absolutely necessary (i.e. a single paragraph spans two or more pages). Additionally, these page numbers must be bolded and have a blank line above and below it.

Example:
(Page 237 Text)...Whatever its broader implications, the theory of sudden revolutions followed by periods of stability seemed to represent the most obvious interpretation of the facts.

Page 238

(First paragraph on Page 238) Catastrophism certainly had had ideological overtones - it was often supported by conservatives trying to resist calls for the gradual reform of society. ...

The other two bolded terms are only inserted for example purposes. Don’t put similar phrases into your documents!

Chapter/Section Headings: Chapter and Section headings should have Font Size 14, Center alignment, and bolded text.

2) Other Headings: All other side headings should be bolded and have Font Size 12. Alignment depends solely on how the text appears in the document.

3) First-Line Indentations: The first line for the first paragraph under every heading (or sub-heading) should have no tab space, regardless of how it may appear in the text. However, the first line for following paragraphs should have a 0.5-inch indent (just press the Tab key once).

4) Sidenotes: In certain areas of books, there exist some comments or notes that are not part of any paragraph. They might be formulas, tips, website links, or many other things. Text of this sort should be contained in a Sidenote (shortcut being ALT + r, s). Sidenotes are not numbered. Place sidenotes at the beginning or end of the closest paragraph, depending on how you see it referenced. Sidebar definitions should come before the paragraph in which it is referenced so the reader knows the definition beforehand. Use your judgment for any others.

5) Footnotes: Move the footnotes from the end of the page (or the footnotes document, as some books will have sections at the end which contain all the footnotes) to the end of the paragraphs in which they are referenced. Use the Footnote shortcut (ALT + r, o) to enclose the footnote text. The number for the footnote (if given) should be placed after Footnote but before the colon with a space separating the number and Footnote.

Inside the text where a footnote is referenced, replace the reference with (Refer to Footnote #), where # is a number. Make sure that this is placed before ending punctuation (periods, question marks, and exclamation points).

Please note that in standard Plaintext editing procedures, the footnote is referenced with the number only (#), where # is the footnote number.
6) Figures: For all figures (remember that the copy/paste process should have removed these), detailed explanations should be given. Generally, these explanations should go after the paragraph in which it is first referenced. If the figure is placed in the text before the figure reference, place it at the end of the nearest paragraph. If the paragraph before the figure has already ended, you can leave the figure where you find it. Use the figure shortcut (ALT + r, f) to enclose your figure descriptions.

In the case where you find a figure too difficult to describe, consult a Team Leader for assistance. With most students, an explanation, along with a photocopy or tactile graphic request may suffice. If the student has requested to have them explained anyway, just give a general, concise explanation of the figure. Again, a Team Leader will know what the student has requested.

To request a photocopy or graphic, you must send an e-mail to the Alternative Format Services mailing list (alt_format@lists.oregonstate.edu). In the Subject line, mention the Student, Course, Book, and Chapter/Section (if given). This aids Team Leaders in organizing and tracking these requests. An example Subject Line would be: “Photocopy Request - S011 BA442 Corrado CH14.” In the body of the e-mail, politely request a photocopy or graphic, making sure to once again mention the information given in the Subject line. In addition, at this point, insert the figure numbers (if given) and the page numbers that coincide with them.

Example:
“Hello everyone,


I would like to request the following figures to be photocopied:

S011 > BA442 > Corrado > CH14

pg 455 - Figure 14.1

pg 456 - Snapshot of Website

pg 461 - Figure 14.4

pg 462 - Figure 14.3, 14.4

pg 463 - Figure 14.5

pg 474 - Figure 14.6

Thanks,

Your Name.”

When you request a figure or photocopy, you must still insert a figure shortcut, but mention that a figure or photocopy has been requested. If additional text is given next to the figure number, also put this in.

Example:
Figure 14.1:
Market analysis of margarine versus butter. A photocopy/graphic of this figure will be provided.

End Figure.
7) Tables: The method of editing a table can be very intricate. You begin by using the table shortcut (ALT + r, b). If the table is numbered in the text, put that number directly after “Table” with a space separating the number and word. All row and cell headings, as well as table titles, are to be bolded. 
Example:
Table 2: Cheese consumption
	Day
	Number
	Types

	1
	5
	Gouda, Feta, Cheddar, Asiago, Provolone

	2
	3
	American, Limburger, Swiss


This table should be formatted like this:

Table 2:
Cheese consumption
Day     

Number   

Types
1   


5   


Gouda, Feta, Cheddar, Asiago, Provolone

2   


3   


American, Limburger, Swiss

End Table.
Notice that extra spaces and tabs appear in parts of this table. As long as you use the minimum spacing requirements, you are more than welcome to add spaces and tables to further align rows to make the table look better.

Note: This method is only to be used for Triangle and Plain Text. The method for editing tables in MathType is explained in the MathType Editing Procedures document.

8) All Block-Level Elements: Here is a list of the shortcuts for all block-level elements (items 6-11 and ones not yet mentioned):

	Block Type
	Shortcut

	Example
	Alt + r, x

	Problem
	Alt + r, p

	Figure
	Alt + r, f

	Table
	Alt + r, b

	Sidenote
	Alt + r, s

	Footnote
	Alt + r, o

	Source code
	Alt + r, c

	Theorem
	Alt + r, t

	Equation
	Alt + r, e


The Problem shortcut is generally used for problems in the back of sections and chapters. Include the entire problem inside the shortcut. Source code is used for computer-based code. This removes the need for excessive tabbing and formatting of code as it would appear in the text.

9) Soft-Hyphens: While editing, you may encounter some very unusual shapes that look like hyphens. These are usually found where, in the text, a hyphen was used at the end of a line. These are called soft-hyphens (¬). Some words are meant to have the hyphens, so global replacement is NOT encouraged. If you choose to globally remove these soft-hyphens, insert normal hyphens into words that look like they are meant to keep their hyphens.

10) Foreign-language Characters: If you encounter any phonetic or foreign-language characters like é, ç, Ǽ etc., replace them with the nearest possible English character. There may be cases in which foreign-language symbols can be used (at the time of this revision, S002 uses a version of OpenBook which recognizes at least German and French letters). A Team Leader will specifically tell you if you can use foreign-language characters. 

11) Non-WinTriangle Screenreader Procedures: In case a student does not use Triangle as their screen reading software, do not use any symbols from Symbol or Triangle fonts for their materials. Use (normal text) exclusively.

After Editing is Done
Once you are finished editing your document, use this checklist to look over the document.

1) Check the following to see you do not miss any:

a. Page Numbers

b. Equation Numbers

c. Example Numbers

d. Figure Numbers

2) Make sure you have either explained all of the figures in the document or requested graphics or photocopies to be made for them.

3) Double-check all equations to make sure all of the symbols are correct. One wrong symbol in an equation could prove problematic for a student the entire term.

4) Make sure the file is saved in the appropriate format (RTF for Triangle and Plain Text, DOC for MathType).

5) Copy the finished file into the appropriate Term > Student > Subject > Book folder. Make sure you keep copies in your own folder and on the Alternative Format Services server until the term is finished.

6) Indicate in the database that you have completed this work. Don’t forget to log your hours every day, even if your assignment takes more than a day to complete.

Miscellaneous
1) When working on exams or quizzes...

a. Maintain confidentiality.

b. Do not work on an exam for a class you are taking.

c. Save these files to a compact disc and label it with the exam and class and that it is for. For Example: MTH252 Spring Midterm 2007.

d. Also save a second copy to the Supervisor’s folder on the Alternative Format Services server under Tests > Term > Subject.

e. Delete any working copies you may have.

f. Give the disk to the Supervisor or Team Leader for delivery.

2) If you are given high priority work (a Team Leader will tell you if they are assigning it, or in the database the assignment description will indicate it is high priority in the notes), stop the work you are doing and do the high priority work first.

Finally, if you are unsure about something, please ASK QUESTIONS! Any team member will be happy to assist you.
Plain Text Editing
Procedures Document

Version 2.0
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Introduction

OpenBook is a screen-reader software that can be utilized to read scanned text. It is typically used for non-technical books such as history books or other materials which are not equation-heavy. The main point to remember with the Plain Text method is that you should be able to do an entire document without inputting anything that’s not directly on the keyboard.

Format Structure
1. Attention to detail in plaintext is crucial, just as in all other formats we work in.
2. All scanned documents are in .rtf format. For OpenBook to be able to read them, they must remain in .rtf format.
3. To cut down on editing, remove tables and figures, and to help us recognize the scanning mistakes, follow these steps:

a. Open the document, highlight all of the text (can be done by pressing CTRL + A or by selecting Edit from the main menu bar, then Select All), and copy the text (can be done by pressing CTRL + C or by selecting Edit from the main menu bar, then Copy).

b. Open a Notepad file (Start button, Programs, Accessories, Notepad) and paste the text that you previously copied (can be done by pressing CTRL + V or by selecting Edit from the main menu bar, then Paste).

c. Open a new Microsoft Word file (can be done by pressing CTRL + N or by selecting File from the main menu bar, then New) and copy (CTRL + C) and paste (CTRL + V) the text from the Notepad file.
4. Once you have done this, save the file to your folder using the naming conventions in the Basic Editing Procedures, or according to the Team Leader’s instructions, making sure that it is in .rtf format.
5. Begin editing by formatting the whole document. To format the document, select Format from the main menu bar, then Paragraph for a-g, Format then Font for h-i. The instructions are below:
a. Alignment:     


Justified

b. Indentation Left:     

0”

c. Indentation Right:     

0”

d. Indentation Special:   

(none)
e. Spacing Before:   


0 pt

f. Spacing After:   


0 pt

g. Line Spacing:   


Single

h. Font:   



Arial

i. Size:   



12 pt
Page Numbering: Page numbers will be done the same way as with Triangle (bold and with an extra line above and below, except with the very first page number in a document in which a line above is not required).

Example:

Page 1
Headings: Main headings (Chapters and Sections), and authors’ names (if applicable) should have a font size of 14 and be Center aligned.

Example:

Chapter 6

Insanity in the Social Order
Section 4.1

Gradients
All other headings should be bold, font size 12, and centered or justified depending on how they look in the hardcopy of the document.

Example:

Summary
Standard and Poor’s Stock Index
First-Line Indentation: The first line for the first paragraph under every heading should have no indent. However, the first lines for paragraphs which follow should have an indent of 0.5 inches. The preferred method of a first-line indent is by simply using a tab space. Another method is to select each paragraph that requires an indent, select Format from the main menu bar, then Paragraph and change Indentation Left to 0.5”.

Example:
Here’s a Header
Here’s your first paragraph.


Here’s another paragraph. The rest of the paragraphs under this heading should look something like this.

Parenthesis Spacing: Extra spaces should fill both sides of text appearing inside parenthesis, brackets, and braces. The easiest way to accomplish this is through global replacement (CTRL + F, Replace tab, enclosing mark in the Find what box, enclosing mark with a space in the Replace with box).

Example:
( text ), [ text ], { text }

(Foot)note Referencing: References to notes (Sidenotes, Footnotes, etc.) should be referenced before any terminal punctuation (periods, question marks, exclamation points). This makes the reading clearer for the student when using OpenBook.

Example:
In the Book it looks like:
Indeed, as Frisch indicates, the interviews are an eloquent testimony as to why the Depression did not produce ‘a more focused critique of American capitalism and culture.’9

It should look like this in the finished document:
Indeed, as Frisch indicates, the interviews are an eloquent testimony as to why the Depression did not produce ‘a more focused critique of American capitalism and culture ( 9 ).’

Symbol Translation: All symbols should be written in text form. OpenBook does not read symbols in the manner that WinTriangle would.

Examples:
( = alpha, ( = beta, (x y = summation_x ^y, ( = least integer greater than begin

If you have any questions on how to write out any symbols, refer to the Greek symbols and problem symbols documents on the Alt Format server (Alt Format folder > Training Editing Procedures > Plain text stuff). If neither of these documents answer your question, ask a Team Leader.

Superscripts/Subscripts: If you have superscripts or subscripts they should be indicated using a ^ for superscripts and _ for subscripts.

Example:
8a ( 8^a, 8b ( 8_b, 8a b ( 8_a ^b

Mathematical Operators: Addition remains the same (+), Subtraction is represented by a small dash (-), Multiplication should be an asterisk (*), and Division should be shown by a slash (/). Unlike Triangle, these symbols should be in Arial font, NOT Symbol. With all symbols, you should have spaces on both sides.

Example:
a ( b ( c ( d ( e ( a + b - c * d / e

Roman Numerals: If you come across Roman numerals in the text, in most cases they must be changed to their numerical equivalents (i.e. XVI should be changed to 16). These cases include when they appear in front pages, indices, and most places within the text itself. The only cases in which Roman numerals are to be left alone are when they are references, mainly to materials that are not in the text you’re editing.

Examples:
King Henry VIII ( King Henry 8

World War II ( World War 2

In Chapter IV of Tergenev,... ( Don’t change

...Schniever, Vol XIX, page 223 ... ( Don’t change

Quotation/Apostrophe Replacement: Quotation marks (“) and apostrophes (‘) need to be changed globally in the document. They will appear initially in your copy/pasted text as marks that go straight up and down. OpenBook cannot read these. Global replacement can be done at the end. Also, many times the apostrophe scans as `. Please make sure to globally replace this as well.

Block Shortcuts: We follow the same procedures (shortcuts) for inserting footnotes, figures, examples, etc. as we use in Triangle.

Note: When you use these shortcuts, the colon (:) is found in Symbol font. Globally replace it once you are done editing the document.

Block Type




Shortcut
Block Type
Shortcut

Example
Alt + r, x

Problem
Alt + r, p

Figure
Alt + r, f

Table
Alt + r, b

Sidenote
Alt + r, s

Footnote
Alt + r, o

Source code
Alt + r, c

Theorem
Alt + r, t

Equation
Alt + r, e

Block Quotes: A block quote is a section of text that you’ll find indented on both sides. Usually, these blocks of text are references or quotes from other sources. When finding block quotes, one should treat them using the same procedure as with footnotes, sidenotes, equations, etc. There is currently no macro for citing block quotes. When citing block quotes, the following convention is to be used:

Example:
In the book it looks like this:
This is a block quote. It is indented on both sides from the normal page margin. You use this when you insert an extended quotation from another source.

It should look like this in the finished document:
Block quote:
This is a block quote. It is indented on both sides from the normal page margin. You use this when you insert an extended quotation from another source.

End block quote.
Note: Notice that the tab spacing on each side of the block quote has been removed.

Unrecognized Symbols: Occasionally, you will run across Copyright ((), Registered ((), Trademark ((), Set Addition ((), and Set Multiplication (() symbols. These are NOT to be inserted. Rather, put the letters inside parenthesis. For copyright, this would be (C). For registered, this would be (R). For trademark, this would be (TM). For set addition, this would be ((). For set multiplication, this would be (().

Finishing a Plain Text Document
When finished with the document, before submitting it as done, please make sure to check the following:

a. Make sure all page numbers are indicated. A quick way to do this is to use the find feature (CTRL + F). Type in Page in the Find what box, click the More button, and check the Match case box. Checking that box saves you the trouble of finding every occurrence of the word page in the text, and only finds the one with capital P’s.
b. Check that there are tab spaces for the first line in every paragraph except those at the beginning of a section.
c. Check the spacing between paragraphs. Only one blank line (depression of the Enter key) should be found between them.
d. Make sure to move the completed file to its necessary location.
e. Make sure to leave a comment in the database, and upon completion, close your task.

Triangle Editing Procedures
Version 4.0
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Introduction
Triangle is a software program that is used by people with sight limitations to read their text. Triangle is designed especially for reading scientific data such as Physics, Chemistry, Mathematics, and other subjects which have equation-heavy material. It recognizes text that is generally used in these subjects which would be very difficult to identify if one was using other screen reading software. To edit a document to be compatible with Triangle, we can edit the document in two ways:

1) Edit the entire document in triangle.

2) Edit the document in MS Word, while using the symbols and conventions that are recognized by Triangle.

The first approach is the best, but it takes lot of time to edit a document in Triangle. Because of this, we generally follow the second procedure. 

The following guidelines must be followed when you are editing a document to be read in Triangle. These guidelines are in addition to the Basic Editing Procedures.

Getting Started
1) Apart from the English alphabet and numerals, the only keys that can be used from the keyboard are:

Braces { }, Brackets [ ], Exclamation point (!), Percent sign (%), Dollar sign ($), Equal sign (=), Semi-colon (;), Quotation mark ("), Question mark (?), Colon (:), Apostrophe (’), Period (.), and Comma (,).

Parenthesis ( ) are to be inserted from the Word Symbol font. This can be more easily achieved by global replacement once you have finished editing the document. All other symbols are to be used from the Word Symbol font.

2) To insert symbols, first search through Appendix 1 to see if the symbol has a shortcut. If you find the symbol, use the given shortcut. If you can’t find a shortcut, or if the shortcut keys are not working, then you must insert the symbol manually. To insert a symbol, select Insert on the main menu bar, then select Symbol.

a. Make sure you are using the Symbol font, select the symbol you want, and then press the Insert button.

b. If the required symbol is not found in Symbol font, try searching for it in the MT Extra and Triangle. If the exact symbol is still not found, ask a Team Leader for assistance.

Note: The dagger symbol (†) can be found under the (normal text) font. Beyond using the dagger, refrain from using any other symbols from (normal text) if possible. For mathematical operators, it is best to place spaces before and after the operators.

3) Common symbols that are often mistakenly taken from the keyboard which Triangle does not recognize are: left parenthesis, right parenthesis, the minus symbol (-), and the division (/) symbol. Take care to use these symbols from the Symbol font.

Editing Procedures
1) Subscripts and Superscripts: To make a character subscript or superscript, select it and press Alt + l, o for the subscript and press Alt + h, i for the superscript. Make sure that the character was raised or lowered by 5 points when you are doing it for the first time. To bring the raised or lowered text to normal, select the required text and press Alt + n, o. You can also do it by navigating to the Character Spacing tab and changing the position to Normal in a similar way you would do for raising/lowering the text.

Note: If for any reason, the shortcuts are not working, you can make subscript or superscript by selecting the required text, right-click and open the Font window. Go to Character Spacing tab, change Position to Raised by 5 pt for superscript and Lowered by 5 pt for subscript. When a superscript follows a subscript, leave a space between them.

2) Fractions: For all fractions we use the hot-keyed expression from triangle: nd. This can be found by opening WinTriangle, select Insert from the main menu bar, then Hot-Keyed Expression, then Numerator Denominator. The numerator goes where the first capital F is while the denominator goes where the second capital F is. For Example, 
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 is represented as ab. Please do not use brackets before and after the fraction markers  and . For your convenience, a shortcut symbol for creating a fraction can be used by pressing ALT+ n, d.

Note: Units are not done using the Triangle fraction symbol. They should be edited normally with a slash. For example, 10 m(s is the right way of editing instead of 10 ms. Also note that the symbol ( is always from Symbol font.

3) Parenthesis Surrounding (Fractions): Don’t use any extra parenthesis around numerator or denominator while using fractions. The fraction mark up will serve as implicit parenthesis for the numerator and denominator. For example, it is sufficient to write a + bc + d instead of writing (a + b)(c + d).

4) Over-scripts and Under-scripts: For expressions with an over-script, we use the shortcut ALT + v, o (((abc(). Enter the over-script value between the parenthesis, making sure to select “abc” and then entering your value. If you delete all the letters first and then type in your value, your text may appear blue and WinTriangle may not recognize what you have put in. For example, 
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 can be written as (((a(. For under-script, the shortcut is ALT + v, u (((abc(). For example, 
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 can be written as (((a(.

5) Vectors: For the vector variables we use the vector symbol  which can be found by using the shortcut ALT + v, e. For Example, 
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 can be written as B. Similar symbols are script (), Roman (), overbar (), tilde () and hat above (). Refer to Appendix 1 for shortcuts.

	Name
	Found in Text
	WinTriangle Format

	Vector
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	B

	Overbar
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	B

	Tilde
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	B

	Hat Above
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	B

	Bold
	B
	(B

	Script
	B
	B

	Roman
	III
	3


Note: The Script shortcut is only to be used with script symbols, not function definitions found in the text (Example: f(x)). Unlike in Plain Text (a format you will learn later), ALL Roman numerals are to be done using this format. Only symbols should be bolded with this format, regular text being done using the Font shortcut menu).

6) Limits Positioning (Integrals, Summation, Etc.): When writing definite integrals (shortcut ALT + g, i ), the limits should be listed BEFORE the integral symbol like a b(. The lower limit should be lowered and the upper limit raised. However, there should be a space in between the limits in normal position. The lower limit is always placed before the upper limit. For all other cases like (, ], etc., limits should be placed after the symbol like (a b and ]a b.

7) Limits: While editing limits, one should type lim and then put the limits in subscript. Do not use under-script markup from Triangle to write the same.
Example:
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The above equation should be edited as follows:

lim x(( x + 22
Equations: Equations must be written in this form: Equation n:, where n is the number of the equation. Make sure that a colon comes after the equation number. The shortcut for an equation is ALT + r, e. When writing equations, the equation should be directly on the next line and have a margin of 1 inch from the left (press tab twice).

Example:
This is how it looks in the textbook: 

(E = h( = 
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[image: image28.wmf]2

(1)

4

ehcR

z

¥

-

       (equation 1)

This is how it should look after editing:

Equation 1:



(E = h(


= hc(


= ehcR(4 (z ( 1)2
If no equation number is explicitly given in the text, then the equation macro is not used.

Example:
This is how it looks in the textbook: 

F = ma

This is how it should look after editing:



F = ma

Matrices and Determinants: Explaining the method of doing matrices is better done with examples. Here is an example matrix from a document:
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This matrix has to be formatted in the following way:

[1, 3 (1st row )

2, 4 (2nd row)]

This means that the values 1 and 3 are in the top row of the matrix while the values 2 and 4 are in the second row of the matrix. Please be sure to list each row on a separate line to avoid confusion. Leave a comma between adjacent elements of a row. Do not use tab spaces.

If the matrix is part of a sentence, break the sentence just before the matrix and after the matrix. For example:

The matrix 
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 is a square matrix. This can be written as:

The matrix

[1, 3 (1st row)

2, 4 (2nd row)]

is a square matrix.

Determinants are done roughly in the same manner as matrices, except bars are used in place of brackets. For example, in the text a determinant appears like this:


[image: image31.wmf]13
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Determinant should be written like this:

1, 3 (1st row)

2, 4 (2nd row)(
Extra/Unrecognized Symbols: The following symbols are not recognized by Triangle:

(, (, (, (
The expression (x( denotes the least integer greater than or equal to x, and (x( denotes the greatest integer less than or equal to x. After editing, please globally replace all of the above symbols using the following convention:

· [image: image165.emf] 

A 

“least integer greater begin” 

· “least integer greater end”

· “greatest integer less begin”

· “greatest integer less end”

Please put a space before and after the sentence when you replace.

Occasionally, you will run across Copyright ((), Registered ((), Trademark ((), Set Addition ((), and Set Multiplication (() symbols. These are NOT to be inserted from the Symbol font. Rather, put the letters inside parenthesis. For copyright, this would be (C). For registered, this would be (R). For trademark, this would be (TM). For set addition, this would be ((). For set multiplication, this would b
Finishing a Document
1) In addition to the checks given in Basic Editing Procedures document, check and replace the following with their Symbol font equivalents: +, >, <, /, and :.

2) Check for - (hyphen) and replace with minus ( ( ) wherever applicable. Never change globally.

3) Insure that all page numbers are in the document. This can be done in a similar method to global replacement. After bringing up the Find and Replace window, type Page into the search box. Click the More button and select the Match case box.

Appendix 1
Note: These are some of the shortcuts assigned the frequently used symbols in the Symbol font. Please use these shortcuts to make your work easier and faster. If a letter is capitalized under Shortcut, you should hold down the shift key for that letter doing the shortcut. Please do not change these shortcuts by tampering with the macros. If you identify the need for more shortcuts or have any suggestions, inform a Team Leader or your Supervisor.

	Symbol
	Shortcut
	Symbol
	Shortcut
	Symbol
	Shortcut

	(
	Alt + g, i
	(
	Alt + d, g
	(
	Alt + g, p

	(
	Alt + s, g
	
	
	(
	Alt + g, r

	(
	Alt + l, a
	(
	Alt + p, n
	(
	Alt + g, S

	(
	Alt + r, a
	(
	Alt + p, l
	(
	Alt + g, T

	(
	Alt + u, a
	(
	Alt + h, b
	(
	Alt + g, u

	(
	Alt + d, A
	(
	Alt + s, s
	(
	Alt + g, s

	(
	Alt + d, a
	(
	Alt + s, e
	(
	Alt + g, c

	(
	Alt + r, A
	(
	Alt + s, n
	(
	Alt + g, U

	(
	Alt + ;
	(
	Alt + n, b
	(
	Alt + w

	(
	Alt + 9
	(
	Alt + b, e
	(
	Alt + p, i

	(
	Alt + 0
	(
	Alt + n, s
	(
	Alt + g, P

	(
	Alt + `
	(
	Alt + /
	(
	Alt + g, o

	+
	Alt + =
	(
	Alt + m, i
	(
	Alt + n, m

	(
	Alt + 1
	(
	Alt + m, u
	(
	Alt + g, y

	(
	Alt + x
	(
	Alt + l, b
	(
	Alt + g, D

	(
	Alt + d, v
	(0th row)
	Alt + m, n
	(
	Alt + ’

	(
	Alt + .
	(
	Alt + g, a
	
	

	±
	Alt + p, m
	(
	Alt + g, b
	
	

	(
	Alt + m, p
	(
	Alt + g, g
	
	

	(
	Alt + 2
	(
	Alt + g, d
	
	

	(
	Alt + p, p
	(
	Alt + e
	
	

	(
	Alt + 3
	(
	Alt + g, z
	
	

	(
	Alt + s, l
	(
	Alt + g, E
	
	

	(
	Alt + n, e
	(
	Alt + g, t
	
	

	(
	Alt + c, e
	(
	Alt + g, k
	
	

	(
	Alt + 5
	(
	Alt + g, l
	
	

	(
	Alt + m, g
	(
	Alt + g, m
	
	

	(
	Alt + m, l
	(
	Alt + g, n
	
	

	(
	Alt + g, e
	(
	Alt + g, x
	
	

	(
	Alt + l, e
	
	
	
	

	(
	Alt + 8
	
	
	
	


Appendix 2
Block Shortcuts
	Block Type
	Shortcut

	Example
	Alt + r, x

	Problem
	Alt + r, p

	Figure
	Alt + r, f

	Table
	Alt + r, b

	Sidenote
	Alt + r, s

	Footnote
	Alt + r, o

	Source code
	Alt + r, c

	Theorem
	Alt + r, t

	Equation
	Alt + r, e


Triangle Symbols
	Triangle Symbol
	Symbol Name
	Shortcut

	nd 
	Fraction
	Alt + n, d

	x
	Vector
	Alt + v, e

	x
	Over-bar
	Alt + v, b

	((abc(
	Square Root
	Alt + v, q

	((abc(
	Over-script
	Alt + v, o

	((abc(
	Under-script
	Alt + v, u

	x
	Tilde Above
	Alt + v, t

	x
	Hat Above
	Alt + v, h

	x(
	Dot Above
	Alt + v, d

	3
	Roman
	Alt + v, r

	f
	Script
	Alt + v, s

	(x
	Bold
	Alt + v, l

	(i
	Italic
	Alt + v, i


Embedded Superscripts and Subscripts
Sometimes in an equation, a subscripted or superscripted item may have its own subscripted or superscripted item. To handle these second-level scripted items, we use the shortcuts ALT + d, n (second-level subscript) and ALT + u, p (second-level superscript). These are shorthand for “down” and “up,” easy enough to remember.

Example:
	Original
	Formatted for Triangle

	x1 x2 ( P(x) dx
	x((1(  x((2(  ( P(x) dx

	ex2
	ex((2( 

	ex12
	ex((1( 2


Sample Document

Page 29
CHAPTER 2

First Order Differential Equations
This chapter deals with differential equations of first order, 

Equation 1(


dydt = f(t, y)

where f is a given function of two variables. Any differentiable function y = ((t) that satisfies this equation for all t in some interval is called a solution, and our object is to determine whether such functions exist and, if so, to develop methods for finding them. Unfortunately, for an arbitrary function f, there is no general method for solving the equation in terms of elementary functions. Instead, we will describe several methods, each of which is applicable to a certain subclass of first order equations. The most important of these are linear equations (Section 2.1), separable equations (Section 2.2), and exact equations (Section 2.6). Other sections of this chapter describe some of the important applications of first order differential equations, introduce the idea of approximating a solution by numerical computation, and discuss some theoretical questions related to existence and uniqueness of solutions. The final section deals with first order difference equations, which have some important points of similarity with differential equations and are in some respects simpler to investigate.

Page 30
Section 2.1

Linear Equations with Variable Coefficients
If the function f in Equation 1 depends linearly on the dependent variable y, then Equation 1 is called a first order linear equation. In Sections 1.1 and 1.2 we discussed a restricted type of first order linear equation in which the coefficients are constants. A typical example is

Equation 2:


dydt = (ay ( b

where a and b are given constants. Recall that an equation of this form describes the motion of an object falling in the atmosphere. Now we want to consider the most general first order linear equation, which is obtained by replacing the coefficients a and b in Equation 2 by arbitrary functions of t. We will usually write the general first order linear equation in the form

Equation 3:


dydt = pt y = gt
where p and g are given functions of the independent variable t.

Sidenote:
Equation 3 gives you the differential formula to be used in general.

End Sidenote.

Equation (2) can be solved by the straightforward integration method introduced in Section 1.2. That is, we rewrite the equation as

Equation 4:


dydty ( ba = (a

Then by integration we obtain ln (y ( ba( = (at ( C from which it follows that the general solution of Equation 2 is

Equation 5:


y = ba ( ce(at
where c is an arbitrary constant. For example, if a = 2 and b = 3, then Equation (2) becomes. Unfortunately, this direct method of solution cannot be used to solve the general equation (3), so we need to use a different method of solution for it. The method is due to Leibniz; it involves multiplying the differential equation (3) by a certain function ((t), chosen so that the resulting equation is readily integrateable (refer to Footnote 1). The function p(t) is called an integrating factor and the main difficulty is to determine how to find it. To make the initial presentation as simple as possible, we will first use this method to solve Equation (6), later showing how to extend it to other first order linear equations, including the general equation (3).

Footnote:
Integrable in the sense expression which can be integrated. This just to show how to use a footnote.

End Footnote.
Example 1:
Solve Equation (6), 



dydt + 2y = 3

by finding an integrating factor for this equation.

End Example.
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Introduction
MathType is the primary editing method used when a student requests their work to be printed in Braille. The actual MathType program only inserts symbols and equations that the Tiger printer can recognize. The format that we use for Braille documents is included in this document, as well as how to set up your documents to print from the Tiger printer.


Upon completion of editing, the page setup is changed and documents are printed on special paper with the Tiger printer. A template has already been created (11 1/2 ( 11) to emulate the dimensions needed to print. However, for reference purposes, a detailed setup of how to change the page setup to print is located in Appendix A. 

Getting Started
1) No tabbing is to be used in this format. Make sure that ALL lines are left-aligned, as opposed to justified which we use for most other formats.

2) Initial Setup 

Method 1:
3) Select all of the text from the RTF file you are editing and copy and paste into a new Notepad document. From Notepad, select all of the text and copy it into the MathType template located in the Formats\MathType directory on the Alternative Format Services server (MathType template.dot).

Method 2:
4) For documents edited in Triangle, which have to be converted to Mathtype, it was found that changing the settings (Font, Font Size and Page Setup) manually using settings outlined in Appendix A worked better than Method 1, as it removed the appearance of unwanted symbols.

5) Change the font (Format under the main menu bar then Font) to Tiger 29 and Size 29. Under the Font window, click the Character Spacing tab and make sure that Spacing is Normal.

6) All symbols and special characters, excluding comma (,) period (.) and hyphen (-) (which should be in Tiger 29), should be from Symbol Tiger Expert. Globally replace the symbols to be done in Symbol Tiger Expert (this method is discussed later). The equal sign (=) is acceptable if it is in Tiger 29, but for consistency, replace from Symbol Tiger Expert.

7) All subscripts and superscripts in equations are to be done in MathType. However, if equations are simple and can be done with symbols and operators from Symbol Tiger Expert, avoid doing them in MathType, as MathType equations occupy a lot of space.

8) Try to do complete equations in MathType. Do not break a single equation into different MathType objects unless the equation is too big to fit on one line.

9) Unlike with other formats, you are allowed to place more than one equal sign on a line.

10) With simple equations not done in Math Type, appropriate spacing between operators should be given.

Example:
a + b ( c is acceptable

a+b(c is NOT acceptable

Note: When the text/equations in two lines appear too close together, use 1.5 line-spacing between them. This is useful especially for successive lines involving complicated equations with fractions. Do not give 1.5 line-spacing unnecessarily.

11) Use apostrophes from Symbol Tiger Expert. When globally replacing apostrophes, paste the apostrophe symbol from Symbol Tiger Expert in the replace window. Do not insert an apostrophe from the keyboard.

12) When converting a document from Triangle, pay close attention to certain symbols and formatting. Make sure that global replacement does not overwrite other symbols that you do not want to be changed.

Using MathType
MathType is a program used to insert mathematical equations and complicated expressions to be printed in Braille. In Microsoft Word, you should see a MathType menu bar (the options resemble Sigma characters). In order to print properly, certain styles, sizes and spaces need to be used. A preference file AFPG1 is created to accommodate the appropriate font type, spacing and symbols.

In order to insert a new equation, select MathType from the main menu bar then Insert Inline Equation. You can also use the shortcut CTRL + ALT + Q to open up a MathType equation window.

The preference file can be set in two different ways:

1) From Word Document (as explained above)

MathType > Set Equation Preferences > Load from MathType Preference File > AFPG1

2) From MathType Window

Preferences > Equation Preferences > Load from file... > AFPG1
Note: The latest preference file AFPG1 is located in the MathType folder on the Alternative Format Services server.

The MathType Template AFPG1 takes care of the required font sizes, styles and spacing, so do not give any additional spacing unless required.


Once you are done editing an equation in the MathType window, press ALT + F4.

MathType Do’s and Don’ts
Fractions: Fractions inside MathType can also be done using the keyboard. Separate the numerator and denominator with a slash inserted from Symbol Tiger Expert.

Do use 
[image: image33.wmf][]

[]

, 
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[]


DO NOT: Use 
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Problem Symbols: Some of the symbols and mathematical operators from MathType do not print properly. If you are unsure of whether the symbol will print, print to a file on ED5. A few of these exceptions are listed below:
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Note: These are NOT the only exceptions...just the commonly used ones. In future if you encounter new symbols make sure they are okay by printing and checking. Also a file of unprintable symbols can be found on the Alternative Format Services server under the MathType folder (Prints_does not print_Renuka(81304).doc).

Parenthesis: In Math Type, all parentheses should be inserted only from the keyboard, even if they look bigger in the hardcopy.

Do use 
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DO NOT use 
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Vectors: Vectors represented as bold characters in text are usually represented with an over-arrow. The arrow above a character does not print properly, so an over-bar is used instead. If the direction of the arrow above the character is of importance, then the arrows can be inserted as over-scripts. Use similar procedures for tilde above, hat above, and dot above.

· Never use 
[image: image41.wmf]x

r

 , the arrow doesn’t print. Use 
[image: image42.wmf]x

 instead.

· Another option is 
[image: image43.wmf]x

®

 , inserting ( in an over-script obtained from [image: image44].

· Use overbar from [image: image45] and NOT from [image: image46].

Limits: Limits for integrals and summations should be above and below rather than a superscript and subscript.

Do use 
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DO NOT: Use 
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Superscript/Subscript Spacing: The spacing for subscript and subscript is predetermined in the Preference file. A superscript should always follow the superscript.

Do use 
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DO NOT: Use 
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Tables: Tables in MathType can be done as a regular Word table using lines and cells. Use bigger cells than the size of the text. For normal text without any fractions/superscripts/subscripts, a row height of 0.7 inch is suggested. Vertically center-align the text and give a space at the beginning. Adjust the cells appropriately to provide some space at the end of text and the next cell. DO NOT center align horizontally. Make sure the table does not go beyond the margins. Split the table appropriately if necessary. For example look into Sample Table.doc on the Alternative Format Services server under the MathType folder.
Example:
	 1
	 2
	 3
	 4
	 5

	 6
	 7
	 8
	 9
	 2245


Note: Changing the described values can be done by selecting Table from the main menu bar then Table Properties. For row height, click the Row tab, check Specify height box, select 0.7", and change Row height is to At least. For vertical alignment, click the Cell tab, select Center under the Vertical alignment group.

Roman numerals: Convert all Roman numerals to regular numbers. Refer to Roman Numeral Notations in Appendix B if you need help with this process.

Spaces: Spacing in Math Type is taken care of by the AFPG1 preference file. This feature works only if the Style (Style is located on the main menu bar) is Math and not Text. So make sure that when you are editing equations, Style is set to Math. Ctrl + spacebar is the shortcut for inserting spaces in MathType. Only use this if you feel you need extra spaces in some cases.

Additional Helpful Points
1. Save your documents frequently. MathType documents use a lot of memory; thus, there is good chance of the application locking up.

2. The process of inserting graphics into most of the MathType documents is referred as merging. Graphics are done separately in another document and later merged with text.

3. When using block-level shortcuts (Figure, Sidenote, etc.), change the colon to Symbol Tiger Expert.

4. To view the whole page on the screen, change the zoom to 75%, provided the screen resolution is 1280 ( 1024.

5. If the equations in the MathType window are too big, reduce the viewing area to 100% by selecting View in the Mathtype main menu bar > Zoom > 100%.

Global Replacement (Very Important!)
1. Select symbol to be replaced from the document and copy it (Ctrl + c).

2. Press Ctrl + F to open the Find and Replace window. Click on the Replace tab.

3. Paste (Ctrl + v) the symbol in the Find what: box.

4. Bring the cursor to the Replace with: space. Click on the More button, then the Format button, then select Font from that list. Choose Symbol Tiger Expert as the font.

5. Click somewhere else in your document to bring the focus away from the Find and Replace window. Go to the Insert Symbol screen (Alt + i, s). Select Symbol Tiger Expert from the Font drop-down list. Select the symbol you want to use as a replacement, click the Insert button. Finally, click on the Close button.

6. Click the Replace All button in the Find and Replace window after you have copy and pasted this replacement symbol into the Replace with box. If it fails to replace the symbol how you wanted, undo (Ctrl + z) the operation and ask a Team Leader for assistance.

Shortcuts in MathType
For your convenience, here are some of the shortcuts in MathType:

	Shortcut
	Symbol
	Result

	Ctrl + Spacebar
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	Space

	Ctrl + h
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a


	Superscript

	Ctrl + l
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a


	Subscript

	Ctrl + f
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d


	Fraction

	Ctrl + /
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d


	Fraction

	Ctrl + r
	
[image: image56.wmf]2


	Square root

	Ctrl + t, n
	
[image: image57.wmf]n

x


	nth root

	Ctrl + g, q
	
[image: image58.wmf]q


	Theta

	Ctrl + g, a
	
[image: image59.wmf]a


	Alpha

	Ctrl + g, b
	
[image: image60.wmf]b


	Beta

	Ctrl + g, g
	
[image: image61.wmf]g


	Gamma

	Ctrl + g, d
	
[image: image62.wmf]d


	Delta (lowercase)

	Ctrl + g, m
	
[image: image63.wmf]m


	Mu

	Ctrl + g, s
	
[image: image64.wmf]s


	Sigma (lowercase)

	Ctrl + g, l
	
[image: image65.wmf]l


	Lamda

	Ctrl + g, p
	
[image: image66.wmf]p


	Pi

	Ctrl + g, w
	
[image: image67.wmf]o


	Omega (lowercase)

	Ctrl + g, r
	
[image: image68.wmf]r


	Rho

	Ctrl + g, t
	
[image: image69.wmf]t


	Tau

	Ctrl + g, D
	
[image: image70.wmf]D


	Delta (uppercase)

	Ctrl + g, S
	
[image: image71.wmf]S


	Sigma (uppercase, summation)

	Ctrl + k, d
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	Partial derivative

	Ctrl + k, i
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	Infinity

	Ctrl + k, =
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	Concurrent with

	Ctrl + g, w
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	Belongs to


Appendix A
1) Open any word document.

2) Select File from the main menu bar, then Page Setup. Under the Paper tab...

Paper Size: Custom Size

Width: 11.5”

Height: 11”

3) Click the Margins tab. Change these values:

Top: 0.5

Left: 0.25

Bottom: 0.5

Right: 0.25

Gutter position: Top

4) All other settings should remain the same, so click OK.

Appendix B
Roman Numerals Equivalents
	#
	R.N. Equivalent
	#
	R.N. Equivalent
	#
	R.N. Equivalent

	1
	I
	20
	XX
	300
	CCC

	2
	II
	30
	XXX
	400
	CD

	3
	III
	40
	XL
	500
	D

	4
	IV
	50
	L
	600
	DC

	5
	V
	60
	LX
	700
	DCC

	6
	Vi
	70
	LXX
	800
	DCCC

	7
	VII
	80
	LXXX
	900
	CM

	8
	VIII
	90
	XC
	1000
	M

	9
	IX
	100
	C
	
	

	10
	X
	200
	CC
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Introduction to Braille

Braille is a reading and writing system of tactile dots for people with vision limitations. Braille was developed by, and named after, Louis Braille. Braille is not a, "Universal Language" as some people assume, although many languages do use the same alphabet. There are many standard systems of Braille for different languages and different purposes, such as encoding math or music. 

The basic unit of Braille is the cell. Many cells have multiple meanings, depending on the language or notation being used and other aspects of the surrounding text.

The Basics of Braille

Standard Braille characters (or "cells"), are composed of up to six dots arranged in two columns of three dot positions each. The dot positions are customarily numbered as follows:

1 • • 4
2 • • 5
3 • • 6

There are 64 possible combinations of raised dots within this pattern (counting the space, where no dots are raised).

A Braille code is a system of assignments of meaning to the various combinations, together with rules for usage. For example, in English Braille, the dots 1-5 combination (that is, only dots 1 and 5 raised, in the same cell) normally means the letter "e," but in some circumstances it can also mean the digit "5" and in others it can be a contraction standing for the word "every." The rules of usage are such that the meaning in any instance is clear.

Some Braille systems employ eight dots in a cell, typically for special uses other than general literary material.

Nemeth Codes:

Nemeth code incorporates Braille indicators.  These are analogous to the composition signs of literary Braille in that they are used to expand on and multiply the number of meanings any particular Braille cells can have. Without them it is impossible to convey, through Braille, the complex expressions that are possible with print.

Editing Procedures:

1. Open Duxbury (Start>Programs>Duxbury>DBT win)

2. Open in Duxbury the .doc or the .txt file to be translated. Check the file to see if any of the text is missing or crappy. If it was a .txt file, save it as .doc and check again. If it was a .doc file, save it as .txt file and check again. Choose the file with the least errors.

3. Save the file with a .dxp extension.

4. Edit the .dxp file as much as possible. Correct errors in the text and also insert the required spacing.

5. To translate the .dxp file to Braille, go to file> translate. Duxbury translates the file into Braille.

6. Save the Braille file with a .dxb extension.

7. When the cursor is held at the start of each line in the .dxb file, a text translation of the line is provided in a yellow highlighted region at the bottom of the window. A thorough line by line inspection of the .dxb file for errors should be done using the text translation as guidance.  

8. Care should be taken to find words or special characters such as -, :, ;  etc. that have not been translated properly. Make corrections by inserting them from the keyboard or creating the word in a new .dxp document, translating it and pasting it on to the Braille document where the change needs to be made.

9. Spacing between lines and paragraphs should be given appropriately. A two line space should be left at the end of each page.

10. Ensure that the text at the start of each page is one line below the automatically generated page numbers on top of each page.

Editing Mathematical Equations:

Note: Use Nemeth code only when working on Mathematical equations.

1. Attention to details is important while working on mathematical equations.

2. The first step is to select the “codes” option in the View menu.

3. Type in the equation by following the codes given in the Nemeth Production Braille guide.

Example: 

Original: She said “3 is correct.”

Duxbury: she said “[cz] #3 [tx] [g2] is correct.”

Braille:


[image: image77.png]



ASCII: ,! Product ( #4@* 6 is ! answ] 4

Note: [cz] is inserted by typing Alt 0 (Zero), [tx] [g2] is inserted by Alt 2.

You can view an entire document in ASCII by selecting view|codes while looking at the Duxbury Braille translation.

Fractions:
Fractions written in Braille require special symbols to convey to the reader how the fractions are written in print. One of these symbols is the Open fraction indicator which indicates that the following is a fraction. This type of fraction should be must conclude with a Closing fraction indicator. The code has symbols to express diagonal slash and horizontal fraction bars.

Follow these examples to get an idea of how it works:

a) Horizontal-bar simple fraction

Syntax:  [cz]?numerator/denominator#[tx][g2]
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This can be expressed as [cz]?1/2#[tx][g2]

b) Diagonal-slash simple fraction

Syntax:  [cz]#numerator_/denominator[tx][g2]

1/2 can be written as [cz]#1_/2[tx][g2]

c) Fractional part of a mixed fraction

3 1/4 can be written as [cz]#3_?1_/4_#[tx][g2]

Square roots:

Syntax: [cz]>number] [tx][g2]

Example: √6 can be written as [cz]>6[[tx][g2]

Level Indicators:

The level indicators are a set of Nemeth symbols that show the Braille readers the spatial orientation of superscripts ad subscripts.

Subscript Indicator:

Syntax: xy expressed as [cz]x;i[tx][g2]

Superscript Indicator:

Syntax: xy can be written as [cz]x^y[tx][g2]

Symbols of Comparison:

Symbols of comparison are equivalent to the comparison signs of print and should not be confused with the signs of operation. They indicate the relation between two sides of an equation. The corresponding Braille symbols are given below:

Equals



= 

.k

Less than


< 

“k

Greater than


>

.l

Less than or equal to
≤

“k:

Greater than or equal to
≥

.l:

Approximately equal to
≈

@:@:

Ratio



:

“l

Greek Letters:
One alphabetic indicator commonly used in the technical material is the Greek-letter indicator. A list of Greek letters and their corresponding Nemeth and ASCII representations are given for your response. The general syntax for inserting the Greek letters is:

Upper case: .,(the first letter of the alphabet)

Example:  Gamma Γ can be represented as .,g

Lower Case: .(the first letter of the alphabet)

Example: Gamma γ can be represented as .g

Printing on the Embosser:
Once you are confident that the DUX version is done (checking the codes), translate it and then emboss it.

1. Before embossing, the following must be done:

a. Turn the embosser off and leave it off for at least 10 seconds. (to reboot the system) Then turn it back on

b. Make sure the embosser is “offline”. (Press OL to do this) Then press “2E” to set the embosser to the top of the page.

c. Be sure the embosser has paper.

i. If not, you can always add more by just lining up the holes in paper with the corresponding feed wheels in the embosser. Press “2E” to feed the paper in to the embosser.

ii. Make sure that the paper is in properly(properly means that the paper will fold by itself once the document has begun printing.

d. Press “OL” again to make sure the embosser is ready to receive a document

e. Now, check the embosser settings in Duxbury.

i. Select “global”, “embosser set up”

ii. Select the “Juliet pro” printer from the drop down list

iii. Check if “treat as interpoint” is selected (this allows double sided printing). If you want a single side print, do not check the box.

iv. Make sure the windows device selected is “Port1_braill_pro_Ne02” (Make sure that this is the correct device)

f. It is a good idea to insert the page numbers into the embossed document. That way, when the document is done printing, it will be easy to put the pages in order.

g. Another good idea is to set the default printer to the embosser. Do not forget to change it back when you want to print normal documents!

2. Embossing

a. Next, click emboss from the file menu and hit emboss all

b. Now, the document should begin to emboss.

c. Once it is done, press “FF” and the paper will begin to feed so that you can detach the embossed document.

d. After detaching, press “2E” to reset the paper to the top of the embosser.

Aligning and Paper Settings:

Alignment is the most important factor that needs to be considered while embossing on a Braille printer. These alignment and the paper settings can be adjusted in the Duxbury software. Follow these instructions for the best results:

1. Click on Global on the Duxbury menu. Changes made under this menu will be global, in the sense that the settings applied here will be the default printer settings

Figure 1:

[image: image166.emf]
2. Click on the Embosser set up

Figure 2:
[image: image167.emf]
3. Click on the appropriate Braille Device from the list. If you do not have the required device in the list, click on New, and select a model (name of the Braille printer). Once the model is selected a Name for the printer should be mentioned in the “Setup Name option. Select “Wide width, 11 Inch long, Braille Paper” option form the Default form drop down list. Once these settings are made Click OK, to see the required Braille device in the Embosser Set up Window

[image: image168.emf]
4. Generally, the characters per line is set to 40 and the lines per page is 25. Check the box for the Emboss in Interpoint if duplex embossing is required.

5. Now,click on document settings to make similar settings. Document embosser settings are different from Global Embosser set up in that the document embosser settings are limited to a particular document that is being printed, while global settings are the default settings.

6. Select Emboss from the file menu, and then select the required settings and click OK.

Archiving Procedures

Version 1.0
[image: image79.emf]

Archiving Procedures

Step 1:

Select the folders/file to be archived”

(The folders can be found on ‘web1/Altformat/Archiving’)

Things to check:

1. The files are named using the correct naming convention

2. There are no discrepancies in the flow of the material (No missing pages)

3. Each individual file has a copyright statement included.

4. There is an instructions/copyright read me file in every folder

After completing step 4, move the folder to ‘Altformat/Archiving/To Be Burned’

Step 2:

1. In the Database, under Work, select ‘All work’

[image: image80.png]Program

Altformat Database

Add Work | Active Work | Complete Work | Archived Work{ |®
Media Access Group: Closed Work List

Search: | Title =]
N I = IS =) T PO ]

438 EnG 213 w2004 WOS 6100 Enaz13 Midsg Alley 385264763 o o
441 e 213 w2005 N/A W05 5100 £nq213 Desert Tracinas 819521574 o o o :
433 e 213 5U2005 WA WOS 5100 Enq213 Classnotes o o o 0 .
437 Biology 102 W2004 WA WOS 5100 B1102 Evolution 60195067 o o o ;
450 History 505 5u2005 WA WOS 5002 HSTS 505 Forman o o o 0 .
446 HST 507 sp2oot wa 1038002 HETS07 Pact 1586452440 o o o ;

Imperfect-Hoffer

WS 5002 HSTS0S Seare, From
WA Rave to Quarks, ode ° o o o :

—_— B B B B

443 History 505 3p2010





2. Search for the book that you want to archive, using the searching option. (Remember to search after selecting ‘All work’)
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3. When the book for which you searched is displayed, click on the edit link that that is the end box of the line displayed.

4. On selecting the edit link, the page containing the details of the book is displayed.
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(You will find more information regarding the details of the book on checking the appropriate textbook log sheets. Look for the term in which the book was used and pull the log sheets from ‘Altformat server’ or ‘Altformat Backup’.)

5. Once you have sufficient information, check for:

· Class (A)

· Work Title (B)

· Author (C)

· ISBN (D)

If there is any variation in any of the data, CHANGE the information in the database to match the excel log sheet. If you have questions, ask a team leader or your supervisor.

6. Click on Archive (F) and enter the Index number in the box (E) next to it using ‘Index number convention’. (ALT-Author name-Book Name). 
7. Click submit only after you have burned the data onto the CD and have checked to ensure that it works.

8. After you click submit, confirm the book is in the ‘Archived work list’.

Step 3:

1. For burning a CD, use the Nero 6 Ultra Edition. This can be found in the ‘Start menu/programs/Nero/Nero 6 ultra edition/Nero Burning ROM’.
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Upon selecting the Nero Burning ROM, make sure that the following options have been selected in the ‘New compilation’ window.

· In the Multisession, No Multisession is selected 

· You have selected CD-ROM (ISO)
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Select the Label tab
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Enter the name for the disk using the naming convention. Since the number of characters is limited, the name of the book can be made short. For example, “The American Freedom” by Foner can entered as FONER_TAF. If the name of the book is a single word, enter as many characters as possible after the Author’s Name. For example, a book written by Wendy on Altformat can be entered as ‘WENDY_ALTFOR’
Select New after entering the Name for the disk.
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Browse in the File Browser window to find the folder that you want to archive. Open the folder and copy all the files to the left most window. Make sure that you have moved all the files before burning.

Select the ‘burn option’ on the toolbar header of the table, and burn the disk.
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In Burn Compilation tab, make sure that the Write box is checked and the write speed is at 24x (3,600 KB/s).

Click on the Burn and burn the disk.

Step 4:

Open the ‘Click and Design’ template for creating the Disk label and Front page.

The pre-formatted page can be found at the following link.

Altformat\Archiving\CD LABEL TEMPLATE\Latest Templates

1. Prepare the appropriate label for the disk and then prepare the front cover.

In the folder “Latest Templates”, open the file ‘Archive Disk and Spine’.

Note: Prepare the Label for the disks after you have burned two disks. The labeler has been designed to print two labels at a time. So, you must create the labels for two disks at a time.
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In the template, update for the following information from the database:

· Title

· Index

· ISBN

· Format

After Updating the contents on the disk, update the Index for the side bar.

Continue and do the second book.

To Print: 

1. Select ‘HP Color Laser Jet 4600 PCL 6”.

2. In the properties of the printer, change the source of the paper to Tray 1.
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Feed tray 1 with the CD Labels facing down and the arrows facing forward.

Step 5:

The pre-formatted page for preparing the front page can be found at the following location.

Altformat\Archiving\CD LABEL TEMPLATE\Latest Templates

Open the file ArchiveFrontplate-ALT-NEW
Make sure that the following fields have been updated:

· Title

· Index

· Author

· ISBN

· Subject

· Date

· Format
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Once you are done updating all the fields, print as mentioned in Step 4.

Make sure that you use Jewel case inserts
Step 6:

After printing the front page and label for the CD:

1. Insert the front and back slides for the Jewel case.

2. Adhere the CD label to the disk and the spine label to the spine of the jewel case.

Procedures for Tactile Graphics
Version 2.0
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Guidelines for Tactile Graphics

Figures can be drawn in any drawing software and then pasted into Word to do the labeling and to print. Microsoft Visio is one such product which is very compatible with Microsoft Word and thus is preferred to other software. This document provides a few guidelines to do figures in Visio and then merge them into Word to do the labeling. The final view in Word, with the figure and labeling, can be printed to a tactile format. The Tiger printer reflects the graphic exactly as visualized in the Word document. The printer can differentiate various shades of colors with variable punch heights. 

There may be several ways to do the Graphics. We have provided the one with which work for us.
Working in Microsoft Visio
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Visio is used to draw figures from scratch. The various shapes, lines, objects, tools, colors, etc. available make it easy to draw the figures. We have created a template with all the tools needed to work on graphics. Always use this template. Visio can be accessed from:

My Computer -> Tap server 
-> Graphics -> Graphics Templates -> Visio template

The Blank Visio template looks like this:
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Some Tips on using figures in Visio

Important: “Never type any text in Visio. Always import the figure into word to insert the text.”

Standard Toolbar
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Formatting Toolbar
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· Use Jumbo or Extra Large arrows.
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· Use lighter color and/or thinner lines for the axes and normal black and/or thicker lines for the curves. Thinner line (1 or 3) for axes thicker line (5 or 9) for curves is good enough.(There are stencils for X & Y axes in the template under Charts, Graphs & Axes)

· Avoid using more than 3 or 4 color shades in a figure as it would be difficult to distinguish. Also, try using lighter shades of the colors.

· Various properties for the object are available on right click as shown in the figures. The two important categories are Format and Shape.


· Shapes can be flipped horizontal/vertical, rotated left/right, and moved in front/backward as shown in the above figure under Shape or from the tool-bar at the top.

· Different line widths, colors, arrow ends, transparency, patterns are available. Similarly different fill colors, patterns, shades with various transparency levels are also available as shown in the above figure under Format.


· Search [image: image92.png]k%)



 to find various desired shapes.

· Use “Shift” key to draw straight lines, move small distances.

· “Snap” and “Glue” properties are available and have some advantages.


· Some shapes come filled with colors, if fill color is not desired choose the fill color as White & the fill patter as “None”. Similarly you can make the borders or lines transparent.


· Use node shape 
[image: image93.emf] to denote points in graphs. 

· Excel can also be used instead of Visio to draw graphs/bar graphs if desired.

· Make sure you give sufficient spacing in the figure to insert text at appropriate locations.

· After creating the graphics, make sure you select all & group the figure, before importing it into Word. The grouping & un-grouping options are available on the top tool-bar.


Tips on Drawing:

· Try to make the graphics as similar to the figures in the book as possible.

· If the figure is too complicated, try to simplify it just enough that none of the information contained in the original figure is lost.

· The figures should not only look good, but should mainly be ACCURATE.

· Do not draw small figures. Always enlarge & draw them, it gives better resolution.

· Some of the irregular shapes are tough to draw using Visio. It is better to draw irregular shapes using Word. Use the Freeform tool for this purpose.

Some other tricks to do the graphics more efficiently can be picked up, but this will come from practice…if you do find something new please tell us, we appreciate creativity

2. Merging into Word


With the figure done in Visio, it is copied and pasted in the Word document to do the labeling and to print into tactile format.

1. Open the Word template created for Graphics. It can be found at:

My Computer -> Tap server -> Graphics -> Graphics Templates -> Word template

2. Copy the figure from Visio and paste into Word.

3. When you paste the figures, the image by default is pasted “in line with text” and it needs to be changed to “In front of text”.
· Select image by clicking on it.

· Right click on the image

· Go to Format Picture ….. 


· Go to Layout Tab in the new 

window & change the

 layout to “In front of text”

4. Select the textbox icon from the drawing toolbar.


5. Place the Text Box in appropriate location on the figure and label it.

6. For the Text Box use the following settings

· Font: Tiger 29, Symbol Tiger Expert for the Symbols

· Size: 29

· Fill : No Fill

· Line: No Line

Note: The last two settings can be done by selecting Format Text Box after right click


Make sure the text box and the image does not overlap each other.

7. Insert MathType inside the Text Box to do mathematical expressions.

8. Resize the image in order to give space for labeling. But try to avoid resizing the figure if it is getting distorted.

9. After the text is done, make sure to group both the text and the figure. This can be done by selecting the grouping option from the “Draw” scroll down menu on the Drawing tool bar.


10. Hold “Alt” key to adjust and/or move the image more accurately and small distances. If you are more comfortable using the key-board, hold down the “Ctrl” Key down & use the cursor keys for fine adjustments.

11. Print the document on to the Tiger 3D advantage.
3. Printing on Tiger Advantage



The view on the Word document can be reflected in tactile format using Tiger Advantage. The document can be printed to either a file or to a printer directly. 

In order to print onto the paper


File 

( Print… 

( Printer Name: “Tiger Advantage 3D” 


( Click “OK”

In order to print to file

Check the “Print to file” Box in the print window


4. Viewing in 3D Viewer



The tactile figures that are printed to the file can be view using “tiger3d_viewer”. So before printing to paper it is always advisable to have a look at the figure printing it to the file. Especially in beginning stage it is recommended that you look at the figures in viewer to have a clear understanding of how the final tactile output would be.

5. Example

Visio Image:

Word Image:


Tiger 3D Viewer Image:

Working With the Flowcharts:

When drawing the flow charts, use the rectangle icon from the drawing for all kinds of boxes



And then use the text box (ref: 2.4 Pg.8) label that particular box

The thickness of the box can be increased or decreased using the Line style icon from the drawing. A line thickness of 3pt or 41/2pt is used.



Arrow styles icon is used to increase the size of the arrow head. Click on that icon to view this window. 
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Plain Text to DAISY

Production Procedures

Version 0.4
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Introduction

These procedures are a description of the Plain Text method for creating DAISY e-text books. They include methods for generating these books from:

· scans of printed material such as textbooks, 

· electronic files delivered by book publishers, and 

· previously edited (legacy) e-text materials.

These procedures are typically used for non-technical books such as history books or other materials which are not equation-heavy. DAISY (Digital Accessible Information SYstem) is a standard for creating “digital talking books,” or DTBs, for use by persons with print disabilities.  DAISY is a major leap forward from current e-text readers such as OpenBook. DAISY DTBs can be read by computer software such as EaseReader or downloaded to portable hardware devices for playback. 

For the purposes of this document, we will be assuming that the user will be using EaseReader to read their DTBs. The main point to remember with the Plain Text method is that you should be able to do an entire document without inputting anything that’s not directly on the keyboard.

Overview of the Process

Section 1.1 Chapter-at-a-Time Editing/Preparation

This guide assumes that the bulk of your Stage 1 work (“Editing and Preparing for DAISY Conversion”) will be done on a per-chapter basis (as opposed to trying to edit/prepare an entire book in one sitting). This is because: 

1. A student may need to start reading chapter material right away in order to keep pace with the class, and you have not been given the lead time to edit the entire book before their class has started. Instead, you will edit, generate, and deliver the material to the student on a per-chapter basis. 

2. It is much easier for you and your coworkers to manage the process if you complete all the steps for each chapter, rather than doing each step in turn on the whole book. This allows you and your coworkers to break the work into discrete units that can be completed in a single work session. All you need to do is record which chapter you completed, and someone else can pick up the work starting with the next chapter.

After one or more chapters have been edited and prepared for DAISY conversion, and you want to deliver them to the student, you will perform Stage 2 (“Generating a DAISY DTB”). You will then follow the Delivery procedure for delivering the DAISY DTB to the student.

At a later time, you will want to go back to the individual DAISY DTBs that make up the entire book and reassemble them into a single complete DAISY book and deliver that to the student. Stage 3, “Assembling Chapters into a Complete Book”, describes this process.

Stage 1 – Editing and Preparing for DAISY Conversion

Section 1.2 Original Textbooks & Other Hardcopy Materials

Save as Plain Text

6. Attention to detail in plaintext is crucial, just as in all other formats we work in.

7. Newly scanned documents will be in .rtf format. Our procedure is to separate a scanned book into individual .rtf files for editing by chapter; i.e., a file for front matter, a separate file for each chapter, and a file for back matter. 


8. To cut down on editing, remove tables and figures, and to help us recognize the scanning mistakes, follow these steps:

a. Open the document, highlight all of the text (can be done by pressing CTRL + A or by selecting Edit from the main menu bar, then Select All), and copy the text (can be done by pressing CTRL + C or by selecting Edit from the main menu bar, then Copy).

b. Open a Notepad file (Start button, Programs, Accessories, Notepad) and paste the text that you previously copied (can be done by pressing CTRL + V or by selecting Edit from the main menu bar, then Paste).

c. Open a new Microsoft Word file (can be done by pressing CTRL + N or by selecting File from the main menu bar, then New) and copy (CTRL + C) and paste (CTRL + V) the text from the Notepad file.

9. Once you have done this, break the book into chapters, saving the chapter files to your folder using the naming conventions in the Basic Editing Procedures, or according to the Team Leader’s instructions, making sure that the files are in .rtf format.

10. In the next section you will edit the individual chapter files in preparation for conversion to DAISY.

Edit the Plain Text

1. Open Files: Open each chapter in Word and compare the pages to the pages in the original textbook. The purpose of editing is to clean up any words and sentences that may have been mangled in the scanning and conversion process. Edit for misspelled words, additional characters, and reinsert missing words or page numbers. Other types of edits will also be made to allow the text to be read properly in the DAISY reader. See the following steps. 


2. Headings and Page Numbers: The first page of a chapter or document should not have any text page numbering appearing on it. All subsequent pages will have page numbers. The reason for this is that it makes for a cleaner DAISY book later in the process. Make certain that any headings on the pages as well as the page numbers are separated from the text, i.e. with an extra line above and below the page numbers and the headings. 


3. Mark Up Heading Styles: The DAISY format conversion tools you will use later can accurately reproduce and index Chapter, Section, Sub-section, etc. headings, if they are properly formatted in Microsoft Word. 

To do this, highlight the text of the heading, then select the Style drop-down field on the Word toolbar and choose the proper heading style. This will “tag” that text as an MS-Word style heading. For the top-level heading (i.e. the chapter title), using the style Heading 1. For lower-level subheadings, subsections, etc. choose the appropriate lower-level heading style (e.g. Heading 2, Heading 3, etc.) in the hierarchy. There can be up to 6 levels of headings. 


Example:

6 - Chapter Title [this is in Heading 1 style].

6.1 Introduction [this is in Heading 2 style].


Introductory text paragraph, blah, blah, blah.

6.2 Primary Colors [this is in Heading 2 style].

6.2.1 Red [this is in Heading 3 style].
4. Word/Sentence Splits: Most important is that regardless of the typeface or wrapping of text lines, the on-screen page will start and finish on the same word(s) as the hardcopy textbook.

a. Hyphenated words that go from one page to the next must be reunited on either of the two pages.

b. If sentences are split between pages they should remain split. 


5. Pictures and Graphics:  For the purposes of this training, remove all pictures and graphics -  we will be determining how to deal with these later.  REPLACE pictures and graphics with the following information in [block] parenthesis:

a. [Picture/graphic titled “place title here” has been removed. Please refer to page #X in the textbook]

b. [Caption “This is a photo of….”]


6. Parenthesis Spacing: By default, EaseReader usually does not verbalize regular parentheses, even if you put spaces between the parentheses and their contents. EaseReader does verbalize parenthesized text distinctively, however. Is this acceptable? If not, we can update the “Lexicon” settings to force verbalization of parentheses. (EaseReader will always verbalize square brackets and curly brackets, whether spaces are added or not).


7. (Foot)note Referencing: We will need to discuss how to handle footnote referencing. We have a few options, shown below – these are verbalized differently in EaseReader. We should determine which is preferable or whether to do something different. Options: square-bracket footnoting [9] or spelled-out footnoting (footnote 9).


8. Symbol Translation: We will stick with the procedure that all symbols should be written in text form. EaseReader does not read symbols in the manner that WinTriangle would. 


Examples:

( = alpha, ( = beta, (x y = summation_x ^y, ( = least integer greater than begin

If you have any questions on how to write out any symbols, refer to the Greek symbols and problem symbols documents on the Alt Format server (Alt Format folder > Training Editing Procedures > Plain text stuff). If neither of these documents answers your questions, ask a Team Leader.

9. Superscripts/Subscripts: If you have superscripts or subscripts they should be indicated using a ^ for superscripts and _ for subscripts. 


Example:
8a ( 8^a, 8b ( 8_b, 8a b ( 8_a ^b

10. Mathematical Operators: Addition remains the same (+), Subtraction is represented by a small dash (-), Multiplication should be an asterisk (*), and Division should be shown by a slash (/). Unlike Triangle, these symbols should be in Arial font, NOT Symbol. In order for EaseReader to read these properly, there should be no spaces anywhere in the equation. [Note that this is the opposite technique from the pre-DAISY method]

Example:
a ( b ( c ( d ( e ( a+b-c*d/e

11. Roman Numerals: If you come across Roman numerals in the text, in most cases they must be changed to their numerical equivalents (i.e. XVI should be changed to 16). These cases include when they appear in front pages, indices, and most places within the text itself. The only cases in which Roman numerals are to be left alone are when they are references, mainly to materials that are not in the text you’re editing.

Examples:
King Henry VIII ( King Henry 8

World War II ( World War 2

In Chapter IV of Tergenev,... ( Don’t change

...Schniever, Vol XIX, page 223 ... ( Don’t change

12. Quotation/Apostrophe Replacement: Quotation marks (“) and apostrophes (‘) do not need to be changed globally in the document. EaseReader will read these correctly regardless of whether they are straight up and down or not.

13. Block Shortcuts: We follow the same procedures (shortcuts) for inserting footnotes, figures, examples, etc. as we use in Triangle.

Note: When you use these shortcuts, the colon (:) is found in Symbol font. Globally replace it once you are done editing the document.

Block Type




Shortcut
Shortcut

Example
Alt + r, x

Problem
Alt + r, p

Figure
Alt + r, f

Table
Alt + r, b

Sidenote
Alt + r, s

Footnote
Alt + r, o

Source code
Alt + r, c

Theorem
Alt + r, t

Equation
Alt + r, e

14. Block Quotes: A block quote is a section of text that you’ll find indented on both sides. Usually, these blocks of text are references or quotes from other sources. When finding block quotes, one should treat them using the same procedure as with footnotes, sidenotes, equations, etc. There is currently no macro for citing block quotes. When citing block quotes, the following convention is to be used:

Example:
In the book it looks like this:
This is a block quote. It is indented on both sides from the normal page margin. You use this when you insert an extended quotation from another source.

It should look like this in the finished document:
Block quote:
This is a block quote. It is indented on both sides from the normal page margin. You use this when you insert an extended quotation from another source.

End block quote.
Note: Notice that the tab spacing on each side of the block quote has been removed.

15. Unrecognized Symbols: Occasionally, you will run across Copyright ((), Registered ((), Trademark ((), Set Addition ((), and Set Multiplication (() symbols. These are NOT to be inserted. Rather, put the letters inside parenthesis. For copyright, this would be (C). For registered, this would be (R). For trademark, this would be (TM). For set addition, this would be ((). For set multiplication, this would be (().

Final Edit and Save 

Alternative 1: Prep for “Using Dolphin Producer with EasePublisher”

1. Page Setup: To allow MS Word automatic page numbering to work properly in conjunction with Dolphin Producer, we need to change the Page Setup parameters to use a much larger paper size, to insure that all the text from each scanned book page will be properly contained within one MS Word page. This will insure that each book page number corresponds exactly with each MS Word page number. To set this, do the following:


a. Select File→Page Setup…
b. Change Paper size to 11” x 17”

c. Click OK.


2. Page Numbering: For Dolphin Producer to be able to properly generate page numbers in the DAISY book, they will have to be defined as Microsoft Word style page numbers. To do this you need to do the following:


a. Turn on Page Numbering in the document by selecting Insert→Page Numbers. This will open a window to set page numbering options; choose Position: Top of Page, and Alignment: Left, and checkmark “Show number on first page.” Then (in this same window) click on the Format… button at the bottom, then under Page numbering select the Start at: radio button and type in the correct page number from the original textbook for this page. Click OK, then OK again. Page numbers will now appear from the beginning to the end of the section, starting at the page number you specified. 

b. Now that you have turned on Page Numbers you need to make sure that each page “breaks” in the proper place so that its text corresponds to the same page number as in the original textbook. This means that at each place in the text where a new page starts in the original textbook, a Page Break will need to be inserted. This is done by positioning the cursor at the proper location within the text and pressing CTRL + Enter. Repeat this procedure throughout the entire section. 

c. Verify that pages don’t overflow: the full text from each page in the original textbook, including footnotes, should fit within a single MS Word page (e.g. between page breaks). If any pages overflow, they will throw off the page numbering when the final DAISY book. If you see overflow on a page, do the following:

i. Select all the text on the page that overflows, including the overflow.

ii. Reduce the font size to the largest size that allows all the text to fit on a single page. 

d. Compare the “in text” page numbers that were scanned in with the MS Word page numbers in the header. These can be used to verify that all page numbering is correct. Once you have confirmed that all the page numbering is correct, you can delete the scanned page numbers. [These could be left in too; there may be no harm in doing that.]

3. Save RTF File: Select File→Save to save the edited document again before conversion to DAISY. You will save it in its current format, RTF.


4. Keep the file open in your MS Word session, and go to the section titled “Using Dolphin Producer with EasePublisher” in Stage 2, Generating a DAISY DTB.
Alternative 2: Prep for “Using Only EasePublisher”

1. Save the File: Select File→Save to save the edited document again before conversion to DAISY. You will save it in its current format, RTF.


2. Re-save as an HTML File: You will want to re-save the file as an HTML file prior to importing it into EasePublisher. Select File→Save As…  and save it as Web Page, Filtered (*.htm; *.html) as shown in the following figure:
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By default, MS Word will use the first line of the file as the Page title. If the first line is not the main heading title of the chapter, you will want to override Word’s default behavior by clicking the Change Title… button:
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Type in the correct title and click OK:
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Then click the Save button on the Save As screen. MS Word will display a warning:

[image: image99.png]Microsoft Office Word

Saving Finocchiarn_CHOL_testrif in this format (Web Page, Filtered) will remove
Office-specific tags. Sorme Office fistures may not be available when you reopen
this page. Do you want to save the document in this farmat?

« To preserve formatting, click No. Then save the dacurment in Web Page format

(HTML)





Click Yes.

3. Close MS Word and go to the section titled “Using Only EasePublisher” in Stage 2, Generating a DAISY DTB.
Section 1.3 File Formats from Publishers

Increasingly, we will be receiving electronic versions of textbooks from the publishers on CD or DVD. These versions will almost always be files that are either in MS Word format (.rtf or .doc) or in Adobe PDF (.pdf) format.  

Unfortunately, these files are delivered to us in varying states of “readiness” for conversion into DAISY – some books will be relatively clean and easy to convert, and others will be quite messed up and require a lot more work to convert. For example, some will be already separated by front matter and chapters with well-organized text that needs relatively few edits, while others will arrive as one large disorganized file with numerous errors.

What will be important in either case (but especially the latter) is that you have the original edition of the textbook (or a perfect copy) to which you can refer as you edit the publisher’s electronic files. This way you can edit them knowing exactly what the printed product looks like, and how to reproduce it effectively in preparation for DAISY conversion. 

MS Word Formats (*.rtf, *.doc)

[Insert procedures for MS Word format conversion/editing here].

Adobe PDF

[Insert procedures for PDF format conversion/editing here].

Section 1.4 Legacy (Previously Edited) E-Text (*.txt, *.rtf, *.doc)

Prepare the Legacy Text for DAISY Conversion

1. Open Files: Open each chapter in Word and compare the pages to the pages in the original textbook. You will be reorganizing the documents to more closely match the page numbering and page breaks from the original book.


2. Headings and Page Numbers: The first page of a chapter or document should not have any text page numbering appearing on it. All subsequent pages will have page numbers. The reason for this is that it makes for a cleaner DAISY book later in the process. 


3. Mark Up Heading Styles: The DAISY format conversion tools you will use later can accurately reproduce and index Chapter, Section, Sub-section, etc. headings, if they are properly formatted in Microsoft Word. 

To do this, highlight the text of the heading, then select the Style drop-down field on the Word toolbar and choose the proper heading style. This will “tag” that text as an MS-Word style heading. For the top-level heading (i.e. the chapter title), using the style Heading 1. For lower-level subheadings, subsections, etc. choose the appropriate lower-level heading style (e.g. Heading 2, Heading 3, etc.) in the hierarchy. There can be up to 6 levels of headings. 


Example:

6 - Chapter Title [this is in Heading 1 style].

6.1 Introduction [this is in Heading 2 style].


Introductory text paragraph, blah, blah, blah.

6.2 Primary Colors [this is in Heading 2 style].

6.2.1 Red [this is in Heading 3 style].
4. Word/Sentence Splits: The legacy text will probably be paginated differently than the book due to historical editing procedures. Before converting to DAISY, we will want to restore the pagination to the way it was in the original book. 

This means that you will need to split paragraphs in the same places where they are split in the book, and make sure that the page numbers are properly placed between the splits. In other words, the on-screen page must start and finish on the same word(s) as the hardcopy textbook. Special rules:


a. For hyphenated words that go from one page to the next in the original textbook, simply place the entire word on either of the two pages in the file.

b. If sentences are split between pages in the textbook, they should remain split between pages in the file. 

Final Edit and Save 

Alternative 1: Prep for “Using Dolphin Producer with EasePublisher”

5. Page Setup: To allow MS Word automatic page numbering to work properly in conjunction with Dolphin Producer, we need to change the Page Setup parameters to use a much larger paper size, to insure that all the text from each scanned book page will be properly contained within one MS Word page. This will insure that each book page number corresponds exactly with each MS Word page number. To set this, do the following:


a. Select File→Page Setup…
b. Change Paper size to 11” x 17”

c. Click OK.


6. Page Numbering: For Dolphin Producer to be able to properly generate page numbers in the DAISY book, they will have to be defined as Microsoft Word style page numbers. To do this you need to do the following:


e. Turn on Page Numbering in the document by selecting Insert→Page Numbers. This will open a window to set page numbering options; choose Position: Top of Page, and Alignment: Left, and checkmark “Show number on first page.” Then (in this same window) click on the Format… button at the bottom, then under Page numbering select the Start at: radio button and type in the correct page number from the original textbook for this page. Click OK, then OK again. Page numbers will now appear from the beginning to the end of the section, starting at the page number you specified. 

f. Now that you have turned on Page Numbers you need to make sure that each page “breaks” in the proper place so that its text corresponds to the same page number as in the original textbook. This means that at each place in the text where a new page starts in the original textbook, a Page Break will need to be inserted. This is done by positioning the cursor at the proper location within the text and pressing CTRL + Enter. Repeat this procedure throughout the entire section. 

g. Verify that pages don’t overflow: the full text from each page in the original textbook, including footnotes, should fit within a single MS Word page (e.g. between page breaks). If any pages overflow, they will throw off the page numbering when the final DAISY book. If you see overflow on a page, do the following:

i. Select all the text on the page that overflows, including the overflow.

ii. Reduce the font size to the largest size that allows all the text to fit on a single page. 

h. Compare the “in text” page numbers that were scanned in with the MS Word page numbers in the header. These can be used to verify that all page numbering is correct. Once you have confirmed that all the page numbering is correct, you can delete the scanned page numbers. [These could be left in too; there may be no harm in doing that.]

7. Save RTF File: Select File→Save to save the edited document again before conversion to DAISY. You will save it in its current format, RTF.


8. Keep the file open in your MS Word session, and go to the section titled “Using Dolphin Producer with EasePublisher” in Stage 2, Generating a DAISY DTB.
Alternative 2: Prep for “Using Only EasePublisher”

4. Save the File: Select File→Save to save the edited document again before conversion to DAISY. You will save it in its current format, RTF.


5. Re-save as an HTML File: You will want to re-save the file as an HTML file prior to importing it into EasePublisher. Select File→Save As…  and save it as Web Page, Filtered (*.htm; *.html) as shown in the following figure:
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By default, MS Word will use the first line of the file as the Page title. You will want to change this to the main heading title of the chapter you are saving, by clicking the Change Title… button:
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Type in the correct title and click OK:
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Then click the Save button on the Save As screen. MS Word will display a warning:
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Click Yes.

6. Close MS Word and go to the section titled “Using Only EasePublisher” in Stage 2, Generating a DAISY DTB.
Stage 2 – Generating a DAISY DTB
Section 1.5 Using Dolphin Producer with EasePublisher

The next step is to generate the DAISY Digital Talking Book (DTB). To do this, you use the Dolphin Producer toolbar plug-in in Microsoft Word.

The Dolphin Producer Toolbar

This toolbar should be visible as a floating toolbar in your Word session or as a series of icons near the top of your Word window. It should look like the following:

[image: image104.png]r Fely

Play Prev Next DTB Open Burn Settings Help




If you do not see these icons anywhere you may need to activate the toolbar. To do this, select View→Toolbars→Dolphin Producer. (If Dolphin Producer does not appear as a toolbar option, then you do not have it installed. See TAP technical support for assistance in installing it).

Making sure your Producer settings are correct

You may only need to do this the first time you use Producer, but you will want to confirm that your DTB creation settings are correct. To do this, click on the Settings button: 
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Select the Audio tab.

Use the following settings:

· Create audio using: <which voice?>

· Volume: 80%

· Speed: 0

· Audio quality: Low (24 kbps) [this does not noticeably affect quality and it will keep the file sizes small]

· Path to save: <which folder/directory?>

· Display style: None (?)

· Create text-only DTB: UNCHECKED

· Launch EaseReader after conversion: CHECKED (to make sure it is created and opens in EaseReader).

Click on OK to save the settings.

Generate the DTB

Click on the DTB button to create the DAISY DTB:
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Producer will ask you if it is ok to save the Word document:
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Click Yes.

A progress bar will then display showing the progress of the DAISY book generation. When it is finished, it will launch EaseReader and open your book chapter. You may want to scroll through the book and check any sections that you want to verify are correct. 

If there are any errors, close EaseReader, go back to your Word session, and make corrections. 

Then press the DTB button again. When you do this, it will ask you if it is ok to save again. This time it will also prompt you:

[image: image108.png]D5 withthe iy ‘Qute test akeady et tha ok,

0 you want to continue anyway and overwite k7

5 ==





Click Yes. The DAISY book will then open again in EaseReader. Once it looks ok, you can close both EaseReader and MS Word and finish building the book using EasePublisher.

Open the DAISY Book in EasePublisher

At this point the book should be mostly completed. All you need to do is open it in EasePublisher and check the Table of Contents editor to make sure the Headings and Page Numbering look correct. If they look good (or after you have corrected them), then you will move on to the final step, Build the Project. 

1. Start EasePublisher:  Ensure that the HASP key is connected. EasePublisher needs the HASP Key in order to work.

2. Open Project: Click on the Open Project menu link. This will open a dialog box:
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When you have navigated to a folder with your DAISY book, it will say “Book found!”. Click OK. You will see the following message window:
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Click OK. 

3. Check Table of Contents editor. The book will be opened in EasePublisher. Look at the Table of Contents editor window and check the headings and page numbers to make sure they look right. If you find anything that needs to be fixed, use the editing techniques described in the section titled Markup the DAISY book in EasePublisher, then return here to move on to the next step.
Build the Project 

The final step is to Build project. This will assemble the text synched with the audio and make a fully navigable DAISY talking book. Select Project→Build project… (or press F9) to open the “Build Options” window. This is where you’ll set the Final Recording options, Quality Settings and Project Location for your computer:
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1. On the Validation tab, make sure that Before validation, automatically fill empty meta data is checked. The other default settings on this tab should be fine.


2. Click on the Encoding tab. Make sure the Build distribution as: (at the bottom) is set to “Daisy 2.02 (audioFullText)”:

[image: image112.png]¥ Resanple istributon fle if needed [22050 Hz Mo -

€ No compression

& Compress auo fies using Fraunhofer IS MPEG Layer 3
™ 2 " e3 auelty mode

Deisy 202 |16 kops 11025 HzMona +| | Good (fast encading)

 edum

ANSINSO Z39.86: [16kbps - 11025 HzMono v| | ¢~ High (slow encoding)

™ Rename all audo fles (e.g. audio names fke ‘0014 _Chapter_3mp3)

. i asorms: ————— | o

Protect aucto fles names [A-Za-20-9_] using ths replacement

Buid options:

Bl distrioution as:

+buldencade

=] [psey 202 (moruttony =] S = b

7 Show buld repart ot endl







3. While on the Encoding tab, all of the other settings should be set as shown above – especially the MP3 frequencies and the MP3 quality mode. They should be set to 16 kbps and Good (fast encoding) unless otherwise directed.


4. On the Folders tab, make sure that Put distribution books in sub folder of: is set to “the current project.”:
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5. Press Start. The project will begin building and you will see the following screens as the work progresses automatically:

a. Validate Project

b. Cleanup

c. Removing audio markers

d. Encode mp3

e. Modify documents

f. Build report


6. At the end, a Build report will display. Check the Build report for errors. If there are any errors, see the Resolving Errors section of this guide, and/or consult a team leader. If there are no errors, click Exit and move on to the next task.

Section 1.6 Using Only EasePublisher

Create new DAISY project in EasePublisher

4. Start EasePublisher: After the file(s) have been edited and saved as .htm, start EasePublisher.  Ensure that the HASP key is connected. EasePublisher needs the HASP Key in order to work.

5. Create a New Project: Under “Create a New Project,” click on “From document(s)”:
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a. The Create new project wizard will open:
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b. Click the Select folder button. The Select/create a new folder dialog will open, looking similar to the following screenshot:
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c. You will want to navigate to the working folder on the server where you will create the new book folder for this project. Then you will click the New folder button. The screen should look similar to the following:
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d. For the New folder name, type in “<book_title>_DTB”; for example:
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e. Click OK. You will return to the Create new project wizard dialog. Here you can now change the Project title to match the folder name you just created, as follows:
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f. Click Next.


6. Add HTML file(s): Now it is time to select the .htm file(s) that will make up your project. Note: in the procedures that follow, the examples will show how you would add multiple chapter files to a new project. If you are only working on the single chapter, the procedures would be identical, except that you only need to select the single chapter file you are working on. After assigning the project title and folder, you will see the screen:
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a. Click on the top right button “Add one or more files to the list.” Navigate to the folder where your *.htm file(s) are, and select them by dragging a selection box around them, or by CTRL-clicking each one: 
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b. Once all of your files are selected, click the Open button. It is possible that you will see a series of screens pop up, one for each file in your project. If you do, they will look similar to the following:
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This is nothing to be concerned about – just click OK for each screen until you get back to the Add files screen. It will look like this now:
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c. Ensure that all your files are listed and in the correct order. You may have to stretch the Name column and scroll the window to the right to see the file names. If there are any files out of order, select them and use the up/down arrow buttons on the right to move them into the proper order.

a. Once your files are in order, click Next.


7. Configure project creation settings: In the next screen you will make sure your project creation settings are properly specified. Make sure the check-box “Import meta data information from the documents” is check-marked, and the “Import all meta data” radio button is selected. Your screen should look as follows: 
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8. Generate the project: click Generate, and allow program to run …

Markup the DAISY book in EasePublisher

From this point forward you will be marking up the assembled documents for final conversion into DAISY. The EasePublisher main screen should now be open with the first section of your book in the text screen. A dialog box titled “Table of Contents editor” should also be visible; if it is not showing, you will want to turn it on by pressing F4 or by selecting View→Open Table of Contents view. Note: you will be going back and forth between these two screens, so you will probably want to leave the Table of Contents editor open for the duration of the DAISY markup process. It provides easy access to the various components you will be marking-up and generally makes the whole process easier. At this point your computer screen should look similar to this:
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1. Confirm chapters in order: The first thing you want to do is make sure the textbook sections or chapters are in the correct order. If something is out of order, under the Headings tab in the Table of Contents editor, highlight the section that is out of order, then use the up or down arrow buttons at the top of the editor window to move the section into its proper order:
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You may also find duplicate headings or other text which is shown incorrectly as a heading in the Table of Contents editor. You can delete these by selecting the erroneous heading in the Table of Contents editor and clicking the red “X” button.

2. Page Number Markup: It may seem odd that we are adding page numbers again, when they are already in the text. What we are actually doing is inserting special page markers in the DAISY book identifying these locations as the start of a new page, so that the user can jump directly to that page number. When the project is complete you will see how these numbers are used for navigation.


a. Select the page number text you want to make into a page marker. It should automatically highlight in yellow. Example: 
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[If it does not highlight in yellow, it means that EasePublisher has not recognized it as a “sentence.” If this happens, you will need to fix it using the following procedure:

i. First, click on the HTML button [image: image128.png]


 on the icon toolbar. This will open up a new window which is a simple text editor. 

ii. Click and drag to select the page number text. 

iii. Press F4 (“Make sentence”). The program marks it as a sentence.

iv. Select File→Exit (or click the X in the upper right corner of the window) to exit out of HTML editor. Click Yes when prompted to save changes.

v. Now select the page number text you want to make into a page marker. It will highlight in yellow.]


b. Press Ctrl + 1. A window will appear:
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c. Enter the page you want. INSERT THE SAME PAGE NUMBER for both Begin page and End page. Under “class attribute,” it should be page-normal.

d. Press Add. The page number will appear again below the page number text, and the page is now properly marked. Example:
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e. Repeat the above 4 steps for each normal page number in the entire project.


3. Front Matter Page Number Markup: Some page numbers, such as the lowercase roman numeral page numbers usually found in the “front matter” section of the book (i.e. table of contents, acknowledgements, etc.) must be marked slightly differently. If you have a book with these page numbers, here is the procedure for marking them: 


a. Select the page number text you want to make into a page marker. It should automatically highlight in yellow. [If they do not highlight in yellow, use the same fix-up procedures as described in the previous step]. 
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b. Press Ctrl + 1. A window will appear:
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c. Enter the page you want. Again, insert the same page number for both both Begin page and End page. This time, under “class attribute,” it should be page-front.

d. Press Add. The page number will appear again below the page number text, and the page is now properly marked. Example:
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e. Repeat the above 4 steps for each page in the front matter section. Note that EasePublisher will revert back to page-normal for the next page marked, so you will have to re-select page-front for each front matter page you mark.

4. Heading and Sub-Heading Markup: EasePublisher should have recognized all of the proper headings in the HTML file(s) you imported into this project, and they should appear in the Table of Contents editor window. If so, you will not have to do this step.

However, if a heading was missed in the editing stage, or if for some other reason you want to add more headings, here is the procedure. It is a similar process to page number markup:


a. Make sure you are looking at the “Headings” tab in the “Table of Contents” window. 


b. Click on the text in the project you want to make into a heading, as in the example below:
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c. After highlighting the desired text, click Ctrl + Shift + S. The following prompt will appear:
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d. Click Yes. Then another prompt will appear: 
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e. Click No.

f. The Table of Contents editor now includes the text you marked as a new heading, and will look similar to the following:
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g. By default it will insert it as a Level 1 heading. To make it something other than a Level 1 heading select the item in the Table of Contents editor, and click the right arrow button to change the heading level:
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h. You should see a “2” next to your new heading after you press the right arrow button. If you want to change it back to a Level 1, just click the left arrow button.


5. Final HTML Edits: Should you notice any typographical errors or other mistakes that were missed during the plain text editing process, you can fix them in EasePublisher. To do this you will use the “Edit the content in the HTML editor” feature of EasePublisher.

a. First, click on the HTML button [image: image139.png]


 on the icon toolbar. This will open up a new window which is a simple text editor. 


b. Find the text you want to edit and change it accordingly.


c. If you have added text, you will want to double-check to make sure EasePublisher has recognized it as a “sentence” to be read aloud. Go back and click your mouse cursor on the text you just added. If the text is highlighted in yellow, then everything is ok – EasePublisher recognizes the text. However, if the text does NOT highlight in yellow, then EasePublisher does not recognize it, and you need to tell it to “Make sentence”: 


i. Click and drag to select the page number text. 

ii. Press F4 (“Make sentence”). The program marks it as a sentence.


d. Once you are finished with edits, select File→Exit (or click the X in the upper right corner of the window) to exit out of HTML editor. Click Yes when prompted to save changes.. 

TTS Encode 

When you have fixed your text and added page numbers and subheadings, you are ready to make a DAISY Talking Book. You must now perform the two final tasks in the product creation. The first is Text-to-Speech (TTS) Encoding. TTS encoding will use computer-generated voices (whichever ones are installed on your computer) to add speech to the DAISY book.

1. Click on Tools→TTS Encode→Whole project [shortcut Ctrl + T]:
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2. The TTS Settings window will appear, as shown below. Select the recommended voice and recording settings. Make sure that after you click on a voice, you click both the Use above settings as default button and the Use above settings for heading tags button. The recommended voice and settings are [need to recommend a voice and settings here]:
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3. Click OK. This TTS encode will take anywhere from five minutes to a half hour depending on the size of the project. While it is encoding you will see a progress window similar to the following:
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Build the Project 

The final step is to Build project. This will assemble the text synched with the audio and make a fully navigable DAISY talking book. After the TTS Encode is done, select Project→Build project… (or press F9) to open the “Build Options” window. This is where you’ll set the Final Recording options, Quality Settings and Project Location for your computer:
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1. On the Validation tab, make sure that Before validation, automatically fill empty meta data is checked. The other default settings on this tab should be fine.


2. Click on the Encoding tab. Make sure the Build distribution as: (at the bottom) is set to “Daisy 2.02 (audioFullText)”:
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3. While on the Encoding tab, all of the other settings should be set as shown above – especially the MP3 frequencies and the MP3 quality mode. They should be set to 16 kbps and Good (fast encoding) unless otherwise directed.


4. On the Folders tab, make sure that Put distribution books in sub folder of: is set to “the current project.”:
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5. Press Start. The project will begin building and you will see the following screens as the work progresses automatically:

a. Validate Project

b. Cleanup

c. Removing audio markers

d. Encode mp3

e. Modify documents

f. Build report


6. At the end, a Build report will display. Check the Build report for errors. If there are any errors, see the Resolving Errors section of this guide, and/or consult a team leader. If there are no errors, click Exit and move on to the next task.

Stage 3 – Assembling Chapters into a Complete Book

At some point, after all of the chapters of a book have been developed in DAISY individually, you will want to go back and reassemble all of them into one complete DAISY book. This stage describes the process of how to put individual DAISY chapters together into a single, larger DAISY book.

1. Start EasePublisher:  Ensure that the HASP key is connected. EasePublisher needs the HASP Key in order to work.

2. Create new Simple project: Under Create a new project, click Simple project. The Create new project wizard will open:
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3. First click the Select folder button. The Select/create a new folder dialog will open, looking similar to the following screenshot:
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You will want to navigate to the working folder on the server where you will create the new book folder for this project. Then you will click the New folder button. The screen should look similar to the following:
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For the New folder name, type in “<book_title>_DTB”; for example:
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Click OK. You will return to the Create new project wizard dialog. Here you can now change the Project title to match the folder name you just created, as follows:
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Click Generate.


EasePublisher will open in a new, blank project with the Project title you entered at the top of the page. Later you will clean things up a bit by removing this on-screen project title, after you have added chapters, in sequential order, to the book.

4. Import chapters: You will repeat this step for each chapter in the book, in order, until all the chapters have been added. Select Project-Import-Import NCC from other folder… as shown below:
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“NCC” stands for Navigation Control Center and is the main index file of a DAISY book (in this case, the chapter “books”). A dialog window will open allowing you to navigate to the folder where your chapter ncc.html file is located:
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Navigate to the chapter folder (example above) and double-click to open it (example below):
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You do not want to select the ncc.html file located here – this is just a temporary file created during an earlier step. You always want to go one folder deeper and open the Daisy_202_audioFullText subfolder. This subfolder contains the finished (validated) DAISY ncc.html file: 
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Select this ncc.html file and click Open. A “Convert to UTF-8” window will appear:
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Press No. The book is actually already in UTF-8 format and EasePublisher has not recognized this, so you need to overcome this bug by pressing No and changing the code page yourself. Once you press No, the following screen will appear:
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As shown in the above screenshot, click on the drop-down menu for Source document’s code page: and choose 65001 (Unicode (UTF-8)). After doing this, click OK. EasePublisher will scan the file and identify all the headings within it. Then it will ask you which headings to import:
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Click the Select All button to checkmark all of the headings. Important: after this, in the Insert at: drop-down menu, you should select Last NCC item. This will make sure your next chapter added will properly appear at the end of the book.

Click Import. The chapter will be fully imported, along with all the headings and page numbers within it. 

You will want to repeat this step (Step 4) again for every chapter to be added to the book. As you do so, your Table of Contents editor window in EasePublisher should be showing the Headings list growing for each new set of headings added. When all of the chapters have been added, you will move on to Step 5 to do a bit of housecleaning.

5. Remove original title heading: During the import process, EasePublisher adds some extraneous material under the original title heading. We don’t need this heading, so we will remove it, which will also get rid of the extraneous material. 

Unfortunately EasePublisher will not let you remove the first heading in a book, but there is a simple workaround for this. As shown in the next screen, select the first heading in the Table of Contents editor window:
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After selecting it, click the down arrow button at the top of the window:
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This will move the heading down one spot in the list, as you can see in the next screen below: 
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After you have moved it down, it is no longer the first heading in the book, and you can delete it. To do so, just click the red “X” button circled in the screen above. You will see the warning message:
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Click Yes. This removes the heading and all the extraneous stuff underneath it, making for a cleaner DAISY book.

6. After you have imported all the chapters into EasePublisher and cleaned up the first heading, you will want to give the Table of Contents editor close examination to make sure all the chapters, headings, subheadings and page numbers are in the correct order.  Look at the Table of Contents editor window and check the headings and page numbers to make sure they look right. If you find anything that needs to be fixed, use the editing techniques described in the section titled Markup the DAISY book in EasePublisher.

Build the Project 

The final step to completing the entire book is to Build project. This will assemble the text synched with the audio and make a fully navigable DAISY talking book. Select Project→Build project… (or press F9) to open the “Build Options” window. This is where you’ll set the Final Recording options, Quality Settings and Project Location for your computer:

[image: image162.png]¥ Before validation, automaically il empty meta data setings

Rectie these meta data for the chosen autput format;
Do not check meta deta
& Mandetory
 Mandatory + Recommendect
 Mandatory + Recommended + Optional

™ Report erar on text evert with no audio synchronizedto

Bt oo Suia i s
iddercode 7] [oasy 202 (maorulten) <] S =

Help

¢ Show buid repart ot encl







2. On the Validation tab, make sure that Before validation, automatically fill empty meta data is checked. The other default settings on this tab should be fine.


3. Click on the Encoding tab. Make sure the Build distribution as: (at the bottom) is set to “Daisy 2.02 (audioFullText)”:
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4. While on the Encoding tab, all of the other settings should be set as shown above – especially the MP3 frequencies and the MP3 quality mode. They should be set to 16 kbps and Good (fast encoding) unless otherwise directed.


5. On the Folders tab, make sure that Put distribution books in sub folder of: is set to “the current project.”:

[image: image164.png]Put the distribution books in sub folder of:
& the current project.

 the spesifiec path

Sub folder names of each distribution type:

Deisy 2.02 (audioFulTexty: [Daisy_202_sudoFulText
Daisy 2.02 (udoNcc): [Daisy_202_sudioticc

239-85-2002 (eudioNix): [Z3886-2002_auclticx:

Complete distribution folder name:

[CISERVERIORKF OLDER Gellio_Affalr_DTENDaisy_202_auciaFullTexty

Buid options: Bl distrioution as:

iddercode 7] [oasy 202 (maorulten) <] S = b
15" Show b eport ol







6. Press Start. The project will begin building and you will see the following screens as the work progresses automatically:

g. Validate Project

h. Cleanup

i. Removing audio markers

j. Encode mp3

k. Modify documents

l. Build report


7. At the end, a Build report will display. Check the Build report for errors. If there are any errors, see the Resolving Errors section of this guide, and/or consult a team leader. If there are no errors, click Exit and move on to the next task.

Resolving Errors

No errors documented yet.

Leave off quotation marks during the global replacement.
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